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HMI Display Editor Color and Enhanced Vision

HMI Display Editor

Use the HMI Display Editor to create the Displays that the controller shows on
its screen after the program is downloaded. When you click on HMI in the
Project Explorer tree, a Display replica opens. The replica reflects the type of
Vision controller you have selected in your project's Hardware Configuration.

Displays tell your operators what to do. You can have your operators log in
with a password, enter setpoints and other data, and instruct the operator
what to do in case of a system problem or alarm. A Display can contain both
text and images. Text and images can be both fixed and/or variable. If the
project is based on a touch-screen controller, you can also assign touch
properties to on-screen objects.

Variables are inserted into a Display to:
& Show run-time values as integers
# Represent run-time values with either text, images, or bar graphs
& Show text messages that vary according to runtime conditions.

The features in the HMI editor are determined by the controller type selected
in Hardware Configuration. The next image is from a project based on a
Enhanced Vision controller comprising a color touch screen.

Send to ||Force elements || Center, space, and align selected Font
to uniform size elements Handler
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‘Touch®
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Draw
Shapes
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Call a Subroutine when this
Display comes on screen

Ui Bittons beskows boMw, .« Subroutres bo run whes thes Daplay. Loads, o Daplaped. and Urloads
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Getting Started with Displays Color and Enhanced Vision

Color and Enhanced Vision

When, in Hardware Configuration, you select an Enhanced or Color Vision, the
HMI editor changes accordingly and shows additional options such as Frame and
Button.

Getting Started with Displays
Text in HMI Displays

Displays can contain both fixed and Variable text. Fixed (constant) text does
not change according to run-time conditions. Variable text can show run-time
values, such as timer values, or display operating instructions according to
system status.

Graphic Images in Displays
Simple geometric shapes can be drawn on a Display.

Graphic images can be imported from the Image Library, or created with a
program such as Microsoft Paint and then imported.

+ Fixed graphic images

This type of image stays on the screen and does not change until a
different Display is loaded by the program.

# Variable graphic images
Variable images change according to the value of a linked operand.
Binary Image Variables are linked to bit operand status (MB, SB, I, T,
0). List Image Variables are linked to integers (MI, SI, ML, SL)

Copy & Paste Displays

You can copy and paste Display elements.

1. Copy the Display element(s) or select all of the elements in a Display.

- B i )
) Start-Up Dizp

lay

----- : Open Display : Program seleck
Add Mew Display

Righit-click =
Dizplay, then zelect
Copy Display .

=saaac] T 1N

Right-click an
element, then select
Copy
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Import/Export Displays Getting Started with Displays

2. Paste the elements into the Display.
2k & g|§ﬁ|ﬂ|g§|iﬂ|ﬁd‘| E
J_I% | % IEI | j:t| |+— F‘aste[ olly ro | A | .| Froperties...

"D"‘ J- LJ-J
Start-Up Dizplay

Custom 4

qFH "EEEL

E=ecute

_Or_
Select Paste from the Edit menu.

Note ¢ » When you paste elements into a Display, the elements paste
into the same relative area in the new net. The elements
'remember’ their original location. Therefore, before you paste
elements into a Display that already contains elements, move
any elements that occupy the same position as the paste
selection.

# If you paste variables that are linked to named constant values,
note that the constant's description is lost during the paste
operation.

&« Variables do not retain their descriptions; they are renamed as
Variable 1, Variable 2, etc..

# To copy elements between projects, copy your selection from
the source project, then open a target project without closing
VisiLogic, either by using the New Project or Open project
buttons or via these options on the Project menu.

If you close VisiLogic, the selection will be lost.

Import/Export Displays
You can export displays and save them as .vld files, then import them into
other projects.

Export
1. Select Export Displays from the Project menu.
2. Select the display you want to export, and click Add.

3. When you have added all of the displays you want, save them as a .vid
file to the desired location.

Note o & Displays that contain Trend variables cannot be exported
« If a Display contains variables that are linked to the String

VisiLogic: HMI Applications 5



Getting Started with Displays Undo

| Library, these strings will not be exported with the variables

Import
1. Select Import Displays from the Project menu.
2. Select the displays you want to import, and click OK; VisiLogic imports the
displays..
3. When you have added all of the displays you want, save them as a .vid
file to the desired location.

Note o # If you do not want to overwrite displays already in the project,
you must use unique names. You can click the Target Display
Names and enter a new name.

Undo
VisiLogic supports up to 10 Undo/Redo actions.

| Conmnection Ladder HMI Help

Clicking on the | !n EE S eg ¢ & K & B4
Unclo button =
opens a list . [ 11:43 Delete Ladder Element - 3MS SCARN !

11:43 Cuk Ladder Net -
11:42 Delete Comment

Selecting an 11:42 Delete Ladder Elernent - SMS COMFIG
tem wil alzo - - -
undio all previous | 11:42 Delete HMI Element: Module 1.Display [:?:{'-.-'arlal:ule. Yariable 3)
items inthe lizt. 11:41 Faste Strips
11:41 Paste Strips
R | T |G IR

The list of supported actions is shown below.

Ladder HMI Project
Delete ladder element Delete HMI Display Compile
Delete ladder net Delete HMI Elements Build All
Delete Comments Clear HMI Display

Cut Ladder Elements Cut HMI Element

Cut Ladder Net Paste HMI Elements

Paste Ladder Element
Paste Ladder Net
Clear Sub

Import Sub

Changing Displays (Jumps)
To change between Displays, set Jumps. A Jump contains a Jump condition,
which is linked to a bit operand, and a destination Display. You can also
change Displays by placing a Load Display function in a Ladder net.
Setting Jumps
1. Open a Display.

6 VisiLogic: HMI Applications



Changing Displays (Jumps) Getting Started with Displays

2. Click on a Jump Condition field, and select an operand.
B Cisplayr Emptying and spin @ Liks & Jumgs |

Link & Subeoutine; iz wil run wihen this Display iz shown on the LCD

3] | Edit-Emptyrg
Click o the linez below bo cauze a jump to a different dizplay.
T 1
BB 5B 52 : Right Amow Canfirm step
Bl 5B 51 : Leit Amow Soap timess
EB 5857 ESC Select Step
5 | D@ # Select Operand And Address
& Diect |
Click on the Jump
condition field, then |SB = |-iE [Kew #E (also Dowm anow for V1 20) E M
link to condition. Cancel
i) LB L & wone =) —
= A
3]
3. Click on Display field, and select a destination Display.
Link. a Subrouttine; this will iun when this Disphay is shown on the LCD
& |[EdtEmplyng

Click on the Ines below to cause a jump to a diferent display.

"1 JumpCondfion G0y

£ B 52 : Fight durowe Conilinm step

[l 5B 51 : Leh Asrow Saap timers

El e 57 E5C Celect Step

EN 5B 46 Key: #6 [also Down anow forv 20)

i Select Display
BB} Display |

Progra nin -~

EEEEEEREEEE

To edit a Jump, click the desired field and make a new selection.

Notese | \When an HMI keypad entry variable is active, and the Enter key is
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed
turns ON. This can be used as a Jump condition.

* | To see a list of Displays in a project together with their Display
numbers, select HMI Information from the View menu.
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Getting Started with Variables Variables

Getting Started with Variables

Variables

Variables enable you to show run-time values, text, images, and bar graphs
on the controller's screen in response to run-time conditions. Bit, or binary text
variables, for example, display text messages on the controller's LCD screen
according to the status of a bit operand.

The maximum number of variables per display depends on the Vision
controller division.

# Standard Vision: supports up to 24 variables

+ Enhanced Vision: supports up to 255 variable

You can also use Keypad Entry Variables to enable an operator to enter a
password, or data such as setpoints from the controller's keyboard.

Variable Editor

When you insert a variable into a display, the Variable Editor opens, showing
you the options that are relevant for that Variable.

Note that for some types of variables, the type of controller selected in
Hardware Configuration may determine some of the variable's properties. For
example, touch-screen models enable you to assign Touch Properties to on-
screen objects.

The next image shows a binary variable used in a V120 project.

Fixed Text & Images
vy Do not change until &

M different Display is loaded
D Vs Play

Variables
Wariable text and images
change according to the
status or value of the

linked operand

This is the
Varlable's
name

Link :

When Cutput When Qutput

1 is OFF, the 3is ON, the

taxt Blocked 8% |MS Sans Serit (8) - a3 text Clearis | =
is displayed displayed

‘Bmm

Description | Conveor Status

Click here to
link an operand

0 3 - Obgect Sensor; Comvepor B3

OK | Concel |
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Getting Started with Variables

Variables

The next image shows n
These enable you to ass

umeric variable options for touch-screen color models.
ign Touch Properties to on-screen objects, and offer

options for depth and color.

<2 Variable: Numeric

mﬁﬁkwmw

[~ Start vath clear field
Min [D%-32768 .|
Max [D# 32767 [«

[ Up/Mown Arrows

e

3

[ Lineanzation
J7/
—c

2 e )

Tt Alteg

Base Format: | Diecimal

Leading | Mo Leading -

SF =l r

[~ Unsigned foamat

Desciiplion : |Vansble 3
Links

Desciiption Fort [MS Sans Seif (8] |

Link: M1 - Setpoint

Color
|| Bsckcoo [T

Hide: [

_J _EJ Fropethies

Dizable view: |

Fonl: -
J ﬂ [MS Sans Serif (8] _~|

Marking view]

_I ﬁl ;E;:..Mm Center Cerber 'I

Legal entry: MB O -Value vithin Linits

J ﬂ Style: 30 [Concave) 'I

=12l

ok | Cancel | Hep |

Hide e Causes the object/text to disappear from view
e Suspends any touch properties

Disable * 'Greys' a button object
e Suspends any touch properties

Marking View .
e Does not affect touch properties

Changes the color of the button to dark blue background, white inverse text

Keypad OK + Turns ON when Keypad Entry value is within legal limits
e Turns OFF when Keypad Entry value exceeds legal limits

After you have inserted Variables into a display, they are shown with that

display in the Project tree.

Click & Displat o Ladder
ick & Dizplay to . .
showy itz YWariables - Main Ml.:'dme .
‘2] g Foutine

: Start-Up Dizplay
) Password
Lo Z] System Status

=) Marual Mods
R EE o b ode
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Inserting a Variable into a Display Getting Started with Variables

Inserting a Variable into a Display
To show variable data:

1. Click on a variable in the HMI toolbar, then click on the HMI screen and
drag your cursor to create a field for the display of the variable data.

I Stant-Up Display

2. Release the mouse button; a dialog box opens, enabling you to define the
source of the variable data.
The next image shows a binary variable, named Switch Status, linked to
MBO.
When MB 0
= 0, the text OFF will be displayed in the field.
=1, the text ON will be displayed in the field.

7

{85 |MSSancSerf(3) | {3 |MS Sans Sen (8) |

OFF oM

Deescriphion : |Svatch Status

Lok :  MBO - Status ] ok | cawel | Hep |

Field: Too Small

If a field is too small to display data, a warning message is displayed at
compilation and download. In addition, monochrome controllers color a field

that is too small in red.
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HMI Displays '"Touchscreen' controllers

HMI Displays
About the HMI Display and Keypad

All Vision controllers offer an integrated HMI operating panel that includes an
LCD screen and a keypad. The screen size, type and keypad vary. Exact
specifications regarding Vision operating panels are included in the user's
manuals.

'Touchscreen' controllers
There are different types of Vision touch-screen models:

Monochrome LCD +

HMI function keypad and virtual keypad
Maximum number of displays: 255

Maximum number of variables per display: 24

W =
ST

=

In these models, activate the virtual keypad by turning SB 22 Enable Virtual
Keypad ON. This must be done at power-up, or before entering a Display
containing a keypad variable. In addition, the Keypad entry variable must be
assigned a Touch Property.

Monochrome LCD +

Virtual keypad only

Maximum number of displays: 255

Maximum number of variables per display: 24

In these models, the virtual keypad opens whenever the user touches a
keypad entry variable that is currently displayed on the screen.

VisiLogic: HMI Applications 12



About the HMI Display and Keypad Inserting a Variable into a Display

[ Enter Password ]
DavI D

B ision 290”

1123|4567 ]|8]9]|0
QWIEIR]IT Y (U] JO|P
AISIDIFIGIH|J KL |+
Enter Password ESC |Z X |GV ]B [N M.
ciearan |[<-] ]| Space |4 | B

-

" m

. 2
m
T
)
o
[n
z
[m]
=
o

%

-]
a

WA yritronieg

=~
i

Note that to enter Information Mode, you touch the touchscreen in an area
that is not occupied by a Keypad Entry variable or other screen object that has

been assigned a Touch Property.

Color Touchscreen LCD+

virtual keypad only

Maximum number of displays: 1024

Maximum number of variables per display: 255

The virtual keypad functions in the same way as in monochrome models.

Inserting a Variable into a Display
To show variable data:

1. Click on a variable in the HMI toolbar, then click on the HMI screen and
drag your cursor to create a field for the display of the variable data.

VisiLogic: HMI Applications 13



About the HMI Display and Keypad Align, Space & Center Display Elements

I Start-Up Dizplay

2. Release the mouse button; a dialog box opens, enabling you to define the
source of the variable data.
The next image shows a binary variable, named Switch Status, linked to
MBO.
When MB 0
= 0, the text OFF will be displayed in the field.
=1, the text ON will be displayed in the field.

7

{85 |MSSancSerf(3) | {3 |MS Sans Sen (8) |

OFF oM

Deescriphion : |Svatch Status

Lok :  MBO - Status ] ok | cawel | Hep |

Field: Too Small

If a field is too small to display data, a warning message is displayed at
compilation and download. In addition, monochrome controllers color a field

that is too small in red.

Align, Space & Center Display Elements
When you align, space, and center elements, be careful not to make them the
same size and align them one on top of the other. If elements are 'fused'
together in this way, they cannot be separated.
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About the HMI Display and Keypad Global HMI Variable Bank

Notee | The HMI display uses a grid which spaces the lines 8 pixels apart. To
optimize Displays and shorten the PLC cycle time, images and variables
should be aligned to grid.

Click to dizplay
the grid

Selectthe

N image, then click
# Align o Le ft ;@} ~ B & A
 — AT

i .

Global HMI Variable Bank

The Global HMI Variable bank can contain any type of HMI variable. When you
open a VisiLogic project, the bank is empty. You enter variables in the bank by
first creating a variable, such as a List of Images variable, and then adding it
to the bank. Once a variable is in the bank, you can refer to it from any HMI

Display; although you can change the linked operand, the rest of the
parameters remain the same.

Why use Global Variables?

Variables take up space in the controller's Flash memory. In some
applications, you may copy and paste a variable to a number of Displays,
changing operand links where required. In these applications, you can save a
great deal of space--and download time--by using a Global Variable, and
referring to it as required. No matter how many times you refer to a Global
Variable, it is a single variable.

Creating and Using Global Variables
1. Either create a new variable and then right-click on it,

or
right-click on an existing variable, then select Set As Global Variable.
= S HM
= 41 Stat-Up Module
+ I Start-Up Dizplay
Back Light Demo

Bar, top s I
<] Temperature, bar graph " Delete

£ Temperalure, degress B Touh B
£ WeatherList of Images Set s Global Variables [, [E8 Gobaivars »|
B Global Variables |EE Get Gobal variable Paramiters

VisiLogic: HMI Applications 15



About the HMI Display and Keypad Global HMI Variable Bank

2. Enter a name for the Global Variable, then click OK.
Z|Set As Global Variables  [X]

ol mather-List of Images

3. The variable is now part of the Global Variable bank; in the Display, the
variable now appears with an arrow, indicating that it is actually a
reference to a Global Variable.

= B HM
- Bis

tart-Up Module

Weather

| Bar. bop
&) Temperature, bar graph
] Temperature, degress
[ ] wieatherd ist of Images
B3 Global Vanables

#H WeatherList of Images

Referring to a Global Variable
Once the variable is in the bank, you can refer to it from any HMI Display.
@ To insert a Global Variable

1. Click on Insert Global Variable, then click on the display and drag
the cursor; the Get Global Variable box opens.

2. Select a variable, then click Link to open the Select Operand and
Address box and link an operand to the variable; the operand
address appears in the Link field

Global Vars List

B Select Operand And Address

Tsrr;peratue, bag gaph

i -]
[ ] rowes |
3. Click OK, then the variable now appears with an arrow, indicating
that it is actually a reference to a Global Variable.
+ To link an existing variable to a global variable.

1. Right-click the variable and select Get Global Variable; the Get
Global Variable box opens.
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About the HMI Display and Keypad Changing Displays (Jumps)

2. Select a variable, then click Link to open the Select Operand and

Address box and link an operand to the variable; the operand
address appears in the Link field

Global Vars List

B Select Operand And Address

Te;'r;:-cr.ature, bas grq:»h

Link

i =
) I I"Jrn-ll

3. Click OK, then the variable now appears with an arrow, indicating
that it is actually a reference to a Global Variable.

Note o \ A Global variable cannot be resized.

* | Deleting the last link to a Global Variable also deletes the Global
Variable.

Changing Displays (Jumps)

To change between Displays, set Jumps. A Jump contains a Jump condition,

which is linked to a bit operand, and a destination Display. You can also load a
Display by placing a function in a Ladder net.

Setting Jumps
1. Open a Display.
2. Click on the Links & Jumps tab.
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About the HMI Display and Keypad Calling a Subroutine via Display

3. Click a Jump Condition field, and select an operand.
Display: Emptying and spin & Links &JumPS]

Link a Subrouting; this will run when this Display is shown on the LCD

133 I| Edit-Emptying

Click on the lines below to causze a jump to a different display.
| || Jump Condition 3 Digplay
5B 52 : Right Arraws Confirmn step
E 5B 57 : Left Armow Soap timers
[N sB 57 ESC Select Step
%
Click on the Jump i
condition field, then

_Cancel |
link to condition. Cancel
8| @None -

i Select Operand And Address
EA Direct |

|SB ﬂ |4B |Ke_l,l: #E [alzo Down amow for V120) |L|

IEHEE
&

4. Click on Display field, and select a destination Display.

Link a Subroutine; this will run when this Dizplay iz zhown on the LCD

67 |[EditEmptying

Click on the lines below to cause a jump to a different display.

Jump Condition 5| Display
SB 52 : Right Arrov Confirm step
E SB 51 Left Arow Soap hmers
[N 5B 57 E5C Select Step

SB A6 Key B 6 [alzo Dovwn arow for '¥120)

1
% Select Display
ﬂ Display |
(%] Pragram run »
1_ il [ Program select =
= (5] Select Step 1]
E Soap
. Soap timers a8
[} e atér E

To edit a Jump, click the desired field and make a new selection.

Notese | \When an HMI keypad entry variable is active, and the Enter key is
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed
turns ON. This can be used as a Jump condition.

* | To see a list of Displays in a project together with their Display
numbers, select HMI Information from the View menu.

Calling a Subroutine via Display

You can use a specific Display to call a specific Subroutine. This Subroutine
will run during the time that the Display is shown on the controller's LCD.

Standard Vision Controllers
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About the HMI Display and Keypad Calling a Subroutine via Display

Ciperatar:
1.Presz F&l

2. Qpen Valvel

1. Click on the button to
zelect a SubRoutine.

57| 9: Emergency OFF
= ]
elect Operand And Address H
2] subRoutine |
2. Click o the cesired 1 Module Ok |
SubRoLtine and -Up
click K. L Mode ﬂl
E ﬁImaI Mode
o (B ks
L] Ernergency OFF

Standard Controllers Only

SBs 33 and 34 function when an HMI Display that calls a subroutine is
loaded/unloaded from the display screen.

4 SB 33: Load Display with linked Call Subroutine
When a Display containing a Call Subroutine starts loading, SB 33 turns
ON for a single scan cycle the first time the linked subroutine runs. Use
this SB to initialize operands in the HMI subroutine.

+ SB 34 UnLoad Display with linked Call Subroutine)
When a Display containing a Call Subroutine starts unloading, SB 34
turns ON for a single scan cycle the last time the linked subroutine runs.
If a Display contains an ASCII String Variable, and the linked subroutine
contains the Display String 'trigger' MB, reset this MB when the Display
unloads by using the falling edge of SB 34.
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About the HMI Display and Keypad Calling a Subroutine via Display

Enhanced Vision

These controllers enable you to call three subroutines:

# One to run for a single scan when entering the Display (On Load Display)
+ One to run the entire time the Display is on-screen (While Displaying)
¢ One to run for a single scan when exiting the Display (On Un-load Display)

In addition, you can link an MB which will be ON while the Display is shown on
screen, or an XB which will change status.

I Stait-Up Display

Runs for 1 scan when Runs while the Display

Runs for 1 scan when
entering Display Is on=screen

exiting Display

Use buttorss beloi, b lnk Subtoutings o run whie this Displeyr Load, 5 Displayed, and Urloads. \ g]
QJILoantal:

,l:| I Pauze Process E ILng':EJd
Lise buttors below to ink Bit-0perand bo mun wide this Display
— _/—-—/] Is ON while Display is an the screen EI
MB 0 -LogninProgiess ———— |

To clear the subroutines and bits, right-click the relevant field.

Uz buttons bebow to ink Subroubiress to run while this Display: Loads, iz Displayed, and Unloads.

3| '| Subroutine 1 —Ehwim 2 € 5 broutine
& Clear SubRoutine |

Use buttons below to k. Bit-Operand to run whibs this Display: iz D) o To: Subrouting 2

@W DI[“F;O! Clear Bit Operand | -
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About the HMI Display and Keypad HMI Information

HMI Information

To see a list of Displays in a project together with their Display humbers, select
HMI Information from the View menu. To see keypad entry variable ID
numbers, click the variable tab.

[ iew || Insert  Buid _ Connection
E' Ledder
=
W i Corfigurstion
i Daka Tables

FB Infarmaticn
BT |
E L,
==} & HMI Information

— | &3 Disploys |3 variobies |
@ Displey Mame
________ 0 31 Stat-Up Module | Unitronics Logo

T 1 | Start-Up Foduls Prowgram select
2 ! Stat-Up Module Progr. edit pazsword
3 | Stait-Up Module Select Step
4 | Start-Up Module Water
5 | Stat-Up Module Healing Sttp Po. 20
5] | Stait-Up Module Step time
7 | Stait-Up Module Soap —_
8 | StatUp Module Eractaeng antl wy M EsC
3 I Stait-Up Module Canfim lep
10 | Stait-Up Module Soap limers - “
11 | Statdp Module Ewecuta? | Changes?

Elements Draw Order
This feature is available in Enhanced Vision controllers.

Except for variables, which cannot be placed one on top of another, the
elements in a display are shown in layers according to the order in which they
were drawn. The last element is on top of the others.

You can change this order by using the arrows in Draw Order.
In the next image, Rectangle 1 is on top of Rectangle 2.
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About the HMI Display and Keypad HMI-Ladder: Load HMI Display: Functions

etk gl L& oe | [E] [oF] | 47 %A Properties,
1 Stal!'u[l Dis Elernents Draw On:ler-

1 Start-Up Display

Linked Operand | Additional D ata

Rectangle Rectangle - 1

Mumber of eritties in display: 2 0K | Appy | Close | Hep |

In the next image, Rectangle 2 is on top of Rectangle 1.

I Start-Up Display

|

L

= Display: ! Start-Up Display

Element Type Lirked Operand | Additional Data Tab Order | Kp Ert. | Touch
----- Rectangle - 2 M, No Mo
HA, Mo Mo

Nunbas of entties in display: 2 OK | Appy | Close | Help |

HMI-Ladder: Load HMI Display: Functions

These Ladder functions call HMI Displays. Use these functions to initially load
the Display, and then to refresh it when your application requires, as, for
example, when you want to update variable display. They are located on the
Ladder toolbar, under the HMI menu.

Note ¢ Load Display functions should not be placed directly on the

Ladder rail, or called by conditions that continually call the
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About the HMI Display and Keypad HMI-Ladder: Load HMI Display: Functions

Display when it is still loaded on the controller screen.

You must use a transitional contact to activate a Load HMI
Display or Load Last Display function.
Load HMI Display

Causes a Display to be shown on the controller's LCD as a response to a
Ladder Condition.

=l
— T8 §  Back Light Q& select Display x|
= [00:00:06.00] |- [T N ———
(=] rriuzic sub timer |. : Dizplay |
{ P -
. gelEsiLegE g S i (=) Wisilogic Display ;l Ok |
lBlEpEy. | 2. Place the function in < | B Show time
=] | 9 the net, then select a S ..... =] Fill the tark Cancel |
Display. T ----- (2] Hydraulic Purp Display Help |
To change the target o (Z) wieather
Display, double-click o i | Music
the function and select o L) Back Light Drema =
@ & different Display .

Accessing a Load Display Target

Right-click the | Frogram select - - ' '

element to x
openthe menu.

Renlace Ladder Element

#dd Element To Watch L
Fird: Pragram select -

Cpen: Program ’*’-'t%.;:____h

Thiz cauzes the Find Thiz opens the
utility to zearch for the Call function's
Call function's target . target . Frogram select

FRG No:9 Custom 4

S t1=99:99  oniggnac
= HMI Stat-Up Disglay t2= gg P gg

Frg erter Help k3= 99:99
Prg edit Pasmwond .
E dit Execute

&) | Program pel=ct

il 56 62 F5 P #nds Hislp
Elzee:Fa Shaild)p Disdlay
Ellse60: F3 Prg et Pas sword

spa=939ac TP

HMI Display Loaded
This turns a linked MB ON when a specific Display begins loading.

EM  EN
DS LOADED

i @ 2| ps LoADED:
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Load Last Display

Loads the last Display loaded by the application. The function works according
to LIFO list comprising the last 24 active Displays.

To see a list of HMI Displays in a project, together with the Display number,
select HMI Information from the View menu.

Resizing HMI Elements
Resize an element by selecting it, then:

+ Dragging the image handles.

Dragging image
hancdles.

# Clicking the Fit to Original Size (content) button.

Click to restore & LA‘I’U - FEHE raT o EE A

rezized element to
itz actual =ize

Stant-Up Display

Thiz iz the current
zize of the element

4

Pos: 35, 1; Size: 18 x 40)--= 52 = 40

Thiz iz the actual
zize of the element

+ Clicking the Element Sizer, then selecting the desired size.
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EL

‘ . Visionlig

11IR

# Selecting more than one element, then make them of uniform size via the
Resize buttons.

2 S| o |
Make Same Size

Dizplay 1

HMI Element Resizing/Rotating Limitations

Elements 'grow' down, and to the right. If resizing/rotating will cause Variable
elements to collide, or any element to extend beyond the boundaries of the
Display, the element cannot be returned to its original size, or resized to a
larger size.

e | ]

Dizplay 2

Ff'l
+I:|+ + L+J

=3
II:I |=|I

Notee | Fit to Original size functions differently for .bmp and for .wmf.

@ .bmp: Resizes the image to the actual size of the element as it
appears in the element's ToolTip; assuming that this size does
not exceed the size of the display screen. If the original image
exceeds the display size, the function will fail.

+« .wmf/.emf: the image will be resized according to the size at
which it was first inserted into the HMI application.

* | 'Original size' cannot be used to resize Variable elements if the

elements have differing original sizes.
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HMI SB and Sls

Note o

Thiz iz the current
zize of the element

4

Pos: 35, 1; Size: 18 x 40)--=[52 x 40

Thiz is the ariginal
zize of the element

Although an imported image can be resized, resizing may result in
some degree of distortion.
To avoid this, use images that are created to match the required size.

Resizing text elements changes the size of the text field, but does not
affect font size.

Fit to Original Size does not affect geometric shapes that are drawn on

the Display.

Shapes that are imported are resized in proportion to their original size.

HMI SB and Sis
Keypad keys

SB 40 Key: # 0

SB 41 Key: #1

SB 42 Key: # 2

SB 43 Key: # 3

SB 44 Key: # 4

SB 45 Key: # 5

SB 46 Key: # 6

SB 47 Key: #7

SB 48 Key: # 8

SB 49 Key: # 9

SB 50 Plus/Minus

SB 51 Left Arrow

SB 52 Right Arrow

SB 53 ENTER

SB 54 Key <i> (ON when in Info mode, may also be turned ON in order to enter
Info mode, via Remote Access or user program)

SB 55 Up

SB 56 Down

SB 57 ESC

SB 58 F1

SB 59 F2

SB 60 F3

SB 61 F4

SB 62 F5

SB 63 F6

SB 64 F7

SB 65 F8

SB 66 F9

SB 67 F10

26

VisiLogic: HMI Applications



About the HMI Display and Keypad

HMI SB and Sls

SB 68 Fi1

SB 69 F12

SB 70 F13

SB71 F14

SB 72 F15

# Description Turned ON Turned Off |Comments

SB 6 |Keyboard is active |By OS By OS

SB 16 |Touchscreen When LCD is When LCD is |The touch property must be
Active, V280 only [touched not touched assigned to a variable. If this

property is assigned, touching
the variable activates it, causing
it to be marked by the blinking
cursor.

SB 17 |Enable/Disable By program By program Enables a message to be
Touch-screen handwritten on the touch-
indication screen with a stylus
(Message Board
function)

V280/290 only

SB 22 |Enable Virtual e ON by Off by default |[Causes a Virtual Touchscreen to
Keypad default in in all other be shown on screen when the
Enable Virtual Touchscreen |models user touches a display entry
Keyboard -only models variable.

(Relevant only to |« By program, e In Touchscreen + HMI
Standard Vision + to enable keypad models (V280),
Touchscreen, not V280 Virtual user turns ON to enable
Enhanced) keypad Virtual Keypad. When ON,
the normal alphanumeric
keypad does not work.
e May be turned OFF by user.

SB 26 |Exiting OS Draw By OS By OS OS Draw Mode means that the
Mode (ON for 1 Turns ON for a controller's Operating System
cycle after OS single cycle when takes control of the LCD screen:
draw) SB 28 turns OFF. e During Info Mode

This happens at + When a Display is entered
the following e When the Virtual Keypad
times: (touch-screen models) is
. When the d|sp|ayed

PLC exits

Info Mode
* Rises the

cycle after a

Display is

entered.
*  When Virtual

Keypad

mode exits.

SB 27 |Disable all keypad |By program By program If SB 27 is ON when a Display is
automation e IfSB22is shown:

(touch-screen + ON, SB 27 = The user cannot navigate
keyboard models turns ON through the variables using
only, V280) automaticall the Enter or Right-arrow

y keys.

= No Keypad Entry Variable

will be marked by the

blinking cursor. In this
case, a variable may be

activated by:

VisiLogic: HMI Applications
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HMI SB and Sls

= Touch (V280 only)--
assuming it has been
assigned the Touch
property.

= By writing the variable
ID # into SI 250, either
via Info or Online mode.

SB 28 |LCD: controlled by |By OS at entry to |By OS Any Ladder- drawn elements
0OS (OS drawing |drawing mode, |when the OS |(ex. Draw Axis, Trends, Draw
on LCD) remains ON exits the Pixel/Line), are cleared when SB

during the drawing mode:|28 turns ON; the programmer
drawing task: = PLC exits |may use the Negative Transition
= Info Mode. Info of SB 28 to refresh these
= Rises when a Mode. elements on the LCD.

Display is = Aftera

entered. Display is
=  When the entered.

V290 enters | = When

Virtual Virtual

Keypad Keypad

mode and mode

displays the exits.

virtual

keypad on

the LCD

SB 29 |HMI keypad By program By OS Turn SB 29 ON after data is
entries complete, keyed into any variable, to
reload vars enable the user to skip keying

in data for the remaining
(Relevant for non variables in the current display.
touch-screen
models: V120, When SB 29 is ON:
V230,V260) ¢ No cursor blinks on screen.
e The current values of all
variables is loaded on
screen.

SB 30 |Current keypad « ByOS e« Whena Use SB 30 to run ladder tasks
entry sets SB 30 « By SB29 Display is |that require data entered via
(HMI keypad turning ON entered |keypad.
entries complete) |, By program |* By turning|* When a variable is active,
(Relevant for non SB31 ON pressing the Enter button
touch-screen e When SB on the keypad signals that
models: V120, 27 and 29 the user has finished
V230,V260) turn OFF entering the value. When

«  When the Enter button has been
keypad pressed for each variable in
entry the current display, SB 30
variable is turns ON.
touched |Note « To immediately re-enable

data entry (restore cursor) turn
SB31 ON

SB 31 |Refresh current By program By OS Restores the Display cursor, re-
LCD screen display activates all keypad entry
variables variables in the current Display.
(Relevant for non
touch-screen
models: V120,

V230,V260)

SB 32 |HMI keypad entry |By OS By OS This turns ON automatically

in progress when the blinking cursor is on

an active variable.

SBs 33 and 34 function when an HMI Display that calls a subroutine is loaded/unloaded from the
display screen.

28
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HMI SB and Sls

Note + ASCII String Display: In cases where a Display contains a Display ASCII String Variable, and the
linked subroutine contains the Display String 'trigger' MB, reset this MB when the Display unloads by
using the falling edge of SB 34.

SB 33 |Load Display with |By OS By OS When a Display containing a
linked Call Call Subroutine starts loading,
Subroutine SB 33 turns ON for a single scan

cycle the first time the linked
subroutine runs..

Use this SB to initialize
operands in the HMI subroutine.

SB 34 |UnLoad Display By OS By OS When a Display containing a
with linked Call Call Subroutine starts
Subroutine unloading, SB 34 turns ON for

a single scan cycle the last time
the linked subroutine runs.

SB 36 |[INFO mode By OS, Remote |Turns OFF

Access, or when user
program exits Info
Mode

SB 37 |Exclude last By Remote 0s Enables user to skip going back
Display from FIFO |Access, or to certain Displays.

program

SB 38 |Invert Touchscreen|By program By program If a Touchscreen text or image
element pixels element is touched and this bit
(Text, images) is on, the pixels in the element

reverse color.

SB 76 |Keypad Entry: By program By program If SB 76 is OFF after Keypad
Focus (V130) Entry, the user must use the
(Press "Enter" 1x) arrow keys to move to the next

variable. Turning SB 76 on
causes the next variable set in
Variable Tab Order to
automatically become active.
(can be used with SB108
SB Press "Enter" 1x By program By program Normally, when a user enters a
108 |(V130) Keypad Entry value on a V130
HMI, the user must press the
Enter button twice:
- Once to 'approve' the value
- Once to jump to and activate
the next variable.
You can control this by turning
both SB 76 and SB 108 ON in
your application. Note that the
user can press ESC to exit
keypad entry mode.

SB Draw: Out of The OS attempts |At the 0s

110 Range to draw a line or |beginning of

pixel outside of |every cycle
the legal limits of

the controller's

LCD.

SB Keypad entry By OS By OS Turns ON for one scan when the

250 |within limits -The current |entered value is within the
(Standard Vision. Display is Min/Max limits set in the
Enhanced Vision either re- variable's parameters.
variables use called or
status operand) changed,

or

-At the
beginning of
the next

program cycle.
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SB Keypad entry By OS By OS Is ON when the entered value is
251 |exceeds limits - The current |within the Min/Max limits.
(Standard Vision. Display is Note - When this SB is ON, the
Enhanced Vision either re- blinking cursor remains on the
variables use called or active variable even after the
status operand) changed, user presses Enter.
or
- At the
beginning of
the next
program cycle.

SI 6 |Current key pressed

S17 LCD Contrast Control: 0=Minimal Contrast, 50=Medium Contrast, 100=Maximal

Contrast

SI9 LCD Backlight intensity

SI 40 |Touchscreen is being touched- X coordinates

If the screen is touched, SI 40 shows the current location on the X axis.

SI 41 |Touchscreen is being touched-Y coordinates

If the screen is touched, SI 41 shows the current location on the Y axis.

SI 50 |INFO delay time - Default by O/S (every power up) = 4 seconds.

e Units: seconds.

¢ Legal values: 0, 3 to 20.

e If you force or store '0' into equal Zero INFO is disabled.

¢ For V290 Touching the <i\> key on the touch screen starts Info Mode Touching
a legal Ladder application variable clears the INFO time.

SI 249 |Last Active Keypad Entry Variable

Contains the ID number of the last active variable.

SI 250 |Currently active keypad entry, read/write.

When either SB 250' Keypad Entry Within Limits' or SB251 'Keypad Entry Exceeds

Limits' turn ON, the index number of the variable is stored here. As you navigate

between variables, as for example with the right-left arrow keys, SI 250 will show only

the numbers of variables that have not been completed.

Note « A value of -1 indicates that, in this particular display, the user has pressed Enter

for all the Keypad Entry variables in the Display.

SI 251 |Previous HMI Display Number

SI 252 |Current HMI Display Number.

To see a list of Displays in a project together with their Display numbers, select HMI

Information from the View menu.

# Description Value Comments
SDW |Keypad entry When a keypad entry
10 variable value variable value is entered,
this SDW 10 holds the
value.
SDW |Variable display The value is checked when a display |When a bit is ON, the
30 bitmap, 0=Normal, |is entered. corresponding variable is
1=Inverse (or It is initialized to 0: displayed in inverted
negative) - At Power-up. (negative) color; black
- When the program exits the pixels are changed to white
Display. and white to black.
SDW |Hide Var The value is checked when a display |When a bit is ON, the
31 is entered. corresponding variable is
It is initialized to O at: hidden
- Power-up.
- When the program exits the
Display.
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Images
Graphic Images in Displays
Simple geometric shapes can be drawn on a Display.

Graphic images can be imported from the Image Library, or created with a
program such as Microsoft Paint and then imported.

+ Fixed graphic images
This type of image stays on the screen and does not change until a
different Display is loaded by the program.

=+ Variable graphic images
Variable images change according to the value of a linked operand.
Binary Image Variables are linked to bit operand status (MB, SB, I, T,

0). List Image Variables are linked to integers (MI, SI, ML, SL)

You can draw graphic images directly on a Display, or import images.

Notese | Although an imported image can be resized, resizing may result in
some degree of distortion. To avoid this, use images that are created to
match the required size.

* | The HMI display uses a grid which spaces the lines 8 pixels apart. To
optimize Displays and shorten the PLC cycle time, images and variables
should be aligned to grid.

Click to display
the grid

Selectthe

image, then click
# | Align to Le ft ;Eﬂ\_ Eq & A
P — Ay

Grid

Stait-Up Display

Color Images
Color Vision supports .wmf, .emf, .bmp, .png, and .jpg.

However, to get the best results, follow these recommendations:

¢+ Create images using a vector-based graphic design program.

+ Set your PC Display color depth to 32-bit: right-click the desktop, select
Properties>Settings, and under Color Quality select 32-bit.

# Create images of the correct size, so that they will not have to be resized
within VisiLogic.
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# Use .wmf or .emf image formats. If these must be resized, they will give
better results than .bmp, .jpg, or .png

Why images may distort when imported into VisiLogic and displayed on the

controller's screen:
Resized images: jpg, png, and bmp are 'lossy', which means that quality is lost
when the image is resized. If images must be resized, emf and wmf will give
better results.

Color conversion: VisiLogic uses the basic pallet shown below. When an image
contains additional colors, an algorithm performs color substitutions
(interpolation. This means that the results may not reproduce the colors in the
original image.

Selecting Quantization

Note that you can select between two algorithms, RGB and LAB. LAB generally
gives better results, however note that the image conversion process may take
longer.

1. From the HMI menu, click Quantization, and then select RGB or LAB.
WML | Took  Help
!Ilk‘_ Touch rl@ B 4 | DiectConnection ~ &

] show Grid =N T A B\ Fopeies.

18 o

Make Same Size

Make Equal Spaces
Center In Display
Page Summarize

Add New Module

Add Mew Display

Font Handler

» [H [

To see the color pallet, select an object Properties from the HMI menus, and
then click on one of the colors.
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Images

O Buttonm O

HMI Object type: Button

Potition

Leit x

Top 57

‘Width

Height 0

Properties

Test Button

Sting from Storage  <Mouse Clek>
Mignment Centes Canter

Ferd MS Sans Seiif [10.8)
Appearance

sergaracoe |
Feeeground Color

Background Style 30 [Comves]
Assign/Edit

Touch ¥ cMouse Click>
Hide <Mouss Chick>
Dizable mode <Moo Click>
Marking view Moz Chck>

I

B
R R |G O I I I

U N (NS [ETE EE IR IEEE MEIT

117 118 119

oK

Cancel |

Hide &dditional Colors

o 112 13 14 150 83

92 [17753 /17754 JNNISS S NN TR

1200121 01220 123
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Images: Fixed

This type of image stays on the screen until a different Display is loaded by the
program.

I Start-Up Dusplay

Click on the
bitmap button

i
iy
and drag the ,@
1€

cursor o create
afield....

Look inc | (3 Analog | & c¥ EB-
Mavigate 1o the =
desired image, Al snadeall B8 i bing [ S PSR FERcE pix.bmp*
and then — =P |8 enalog] 6428 pix.bmp J

double-click it. | My Recent | analog? 64%28 pixc.bmp
Documents | wrislog3 64%28 pix.bmp
B ) analogh 64X28 pix.bmp

- 4 analog? 6428 pix.bmp
Desklop *a analog8 6428 pix.bmp

‘g File name:  [themo 12434 pix berg =] Open I
MyMetwodk,  Files of lype: |F'u;tur=:. [berg, o, g, wrd, emi, ico, cur) L] Concel
Places [ Open as read-only

The image appears an I Stait-Up Display
the display, togather

with it's properties. —
oo Wl N e " HMI Object type: Bitmap
Position
Lelt 36
Click to fit the image Top 3
to it's actual size. Wwidth 43
Height ]l
Propeities
Picture 'ﬁ
Aszzign/E dit
Trescture Tranzparency Opaque /]
Touch B <Mouse Cicks
Hide <Mouse Chck:

Once the image is on the display, you can open its properties by double-
clicking it. Note that via Properties, you can resize the image and open it in
Microsoft Paint for editing.

Variable Images
Variable images change according to the value of a linked integer.
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Images

Binary Image x|

s 2B - 47 4B

AZ3x2B -2 47 w4k

Description : |Pressue Status

FB 100 - Outlet W akve

0k | Concel | Hew |

Operator;
1. Press ESC

£ OpenValve | e
3. Call Supervizor

Image Library
A library containing hundreds of images can be found in the Unitronics folder
on your hard drive ( Unitronics\VisiLogic\Data\Images).

This makes it easy to locate and import images into your displays.

Note o

An imported image cannot exceed the size of the controller's display
screen listed in the model's technical specifications. For example, the
V230's Display screen is 128x64 pixels, therefore an image of 100x100
pixels cannot be used unless it is resized in a third-party utility such as
Paint.

Clicking any HMI image in a Display will open the Image Library; to
open the image for editing In Paint, click the Paint icon on the lower left
side of the Library frame.

For tips on how to edit images to best suit the controller's Display screen, first
read the Help Topic Creating Images with Microsoft Paint, and then view the
demo located on the VisiLogic setup CD: Edit Image Collections with Paint

Step 1.exe.
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Images

Open

?X

Look r: [ ) Images

2. &1

Computer hardware

Ny, 4

3

ArToas

[}
&

Edit

=~ & @&ekE-

]
= -
u_::- artt
= S L%
AMETIe s, g9
= E ERE
P ™ o e
= 2
Collections
J
Indusbry W

.:,:).J File name: I

B2 Open |

Flaces

My Network — Fie of lype | Pictures (bmp. g, ipg, wd, emf, ico,cu) v ] Cancel

Drawing Shapes on a Display

VisiLogic's Shape toolbar enables you to draw lines, rectangles, rounded
rectangles, and ellipses. Color Vision series also include Frame and Button.

The Display Grid can aid in sizing and aligning images directly on a Display.
- |53 €| A B Frore

1. Select a shape.

2. Click anthe dizplay
to anchar yaur
cursor, and draw
the shape by
dragging the cursar
across the screen.

I Start-Up Display

You can edit an object's properties.

36
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To edit an object, double-
click it to open the

[ ohiect's Properties. I Start-Up Dizsplay
| HMI Object type: Recrale |
Poszition
Leit 57
Tep # o
Widlk E0 o ot
. o edit a L1
Fanght L property, click it. |= O
Attnbutes
Fill False
FPeriwfidth 1
PenStyle Sold
Hatch tyle Cross
MHore
Hamzontal
Vercal
Upward-Diagonal
You can also resize a shape by clicking it, then dragging the image handles.
Draw Static Axis

This HMI utility enables you to place background axes for graphs.

1. Click on Create Static Axis, then click on the Display.

2. Create Static Axis opens, drawing the axis and showing the default
settings.

3. Edit the default settings, if desired, then click OK.

The default settings may be edited; you can also select whether to place a
frame around the Draw area.

Selecting this
places a frame

I Start-Up Digg

] ] around the
# Create Static Axis drarwving area.

I
(. — : Axes Oigi Genesal
Click on Create Static QIR )
. &iz, then click on the X StatPositiors [18 | ¥ Diaw Frama
{;} Display; Create Static il
\ | &xiz apens, drawing the Y Start Position: [222 ~ ~ Thickness: |2
g axiz. Az W Aig J
P Drawing Area: Widte [298 « [ s | Drawing Area: Height: [218 |
These are ediable L Ticks Ticks
default settings . T = 2 =
# | Length (+-) | Thickness Spacing # | Length (+-) | Thickness | Spacing
& Shawy the axes when 1 2 0 1 2 il
a subrouting runs . 2 A0 1 10 2 An 1 10
1 BEP” ool LE LN RN AN Ok | Concel |  Hep |
53| |Draw Trend .=~
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Lock Display
Locking a Display prevents you from moving display elements accidentally.
When the Display is locked, you can continue adding new elements. In a
Locked display, the elements are marked with red; unlocked displays are
marked by green.

[% Filling system
s

=

&Y

ik

-:EI .

@ gdﬂz;;i?tl;rs

o

%chu:k Elerments Togagle
System Images

You can customize your application by replacing system images, such as the
Unitronics' Splash Screen, and the Unitronics' icon that appears in Information
mode, with you own custom images.

1. On the Project menu, click System images.

2. Click on the desired image, click on Replace Image, and navigate to your
custom image..

F Risplace mage 13 B3 Prevvees

a :::&i n 1z =

Systiem Desorpbions ‘ ‘
{1 troort Subroutine L
B Exot St (i
8 e smmmmcvn | | NS W% uniTrRoNICS®
B oo =.v13) vas) =S = i +
Bl Crests Ladder Passoword b i
B TCPMP Project Settings ' ‘ \

Propseriees £ > B
ﬂ: Sysbern Inges I& Dwmermons: 320 » 240

Descopbion:  Bind Mode Sceeen
[ ok | Conce Help |

Notes o \ You can restore default System Images by clicking on the appropriate
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Display Variable Types

\ button

* | You can replace the virtual keypad images; however note that the
touch locations for the keys will not be changed from the default.

Display Variable Types
Variable Types

Note that some of the variables listed below and shown in the next picture are
dependent on controller type.

Text Image Numeric Clock Timer /Counter | SD
Variable Variable Variable Variable Variable
Binary (bit) Binary Number Real Time Timer SD
Text Image Clock Browser
List of Texts: List of Password Clock Counter
by Pointer Images: by Variables
Pointer
List of Texts: List of Bar/Shape Clock
by Range Images: by Graph Variable:
Range Trend View\Enter
Graph RTC\UTC
Value

ASCII String

Display RTC
(ASCII)

Taxt,
fixed
amd
varable

LY

Images,
fixed
amd
variable

—

Mumeric
“ars

Graph
Vars

Clock
“ars

Rkl

Time/
Count
Vars

D Vars
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Bit (Binary) Text Variable

This type of variable displays a different text message on the controller's LCD
screen according to the status of a bit operand.

1" Image
Thiz image iz displayed
wehen the linked

operand iz OM (1],

3 Variable: Binary Text
94 Tewt = {5 Image ~ [T Mumerc -k

0" Text

Thiztext iz
displayed when
the linked operand

ph =1, Clock =2 Timer =& Counter =

= Elre (12, {8 [MS Sans Seri (9) i3 [MS Sans Seiif (8) -l
Bit Operand crveeyor OF, |Clear Corveyom

The status of this

operand

determines wwhich
text iz shown,

Description : | Convepor #3 Stalus
T | ok | cancel | Hep |

~Link : 0 3: Alarm: Eox iz Stuckl
—F"'-FF'?

£

When Output 3 is OH (1)
The Yariahle field shows the
message; "Clear Conveyor',

Status
lear Conveyo

Inserting and Defining the Variable

Click on the variable in the Variable toolbar, then click on the HMI screen
and drag your cursor to create a field for the display of the variable data.

2. Release the mouse button; a dialog box opens, enabling you to define the
source of the variable data.

3. Link a bit operand, and enter text for both bit states.

=

=1 Yarable: Binary Text
—— | Enter textto he -

o« - i -4 - i - Ertertextto b

o S P Mumetic = 1,- Clock =L Timer Eq Enter text to bhe

dizplayed when

‘E}_’ Fhe linked operand the operand is
i= OFF (). O (1),
) |Ms Sar}}' /Errr[m— *I
Clear Corvepor #3 Corveyor #3 Clear ;l
4 k I

Dezcription : Il:cunve:_l,lnr Alarm

ik © |3 e bow s Stuck 1ok | cacel |
— —

A‘ Link & bit operand.
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About the HMI Display and Keypad Display Variable Types

Color Vision series also offer a Switch property. Selecting Switch assigns an MB
and built in Touch property to a binary variable. Touching the variable toggles

the image or text displayed.

Bit (Binary) Image Variable
This type of variable displays a different image on the controller's LCD screen
according to the status of a bit operand.

Binary Image x|

2% 28> 47 w46 [ E YT

Descnption : |Pressure Status

0k | Concel | hHew |

FB 100 - Outlet V' abve

Operatar;

1. Preszz ESC

£, OpenValve |
3. Call Supervizor

Inserting and Defining the Variable

1. Click on the variable in the Variable toolbar, then click on the HMI screen
and drag your cursor to create a field for the display of the variable data.

2. Release the mouse button; a dialog box opens, enabling you to define the
source of the variable data.
3. Link a bit operand, and select images for both bit states.

Selecting Switch assigns an MB and built in Touch property to a binary Text or
Image variable. Touching the variable toggles the image or text displayed.
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Numeric (Number) Variable
A Number Variable enables you to:

¢ Show any numeric value within a Display.

# Control the format in which that value is shown, including the placement
of a decimal point and leading zeros.

¢+ Use Linearization to show a converted value, such as an analog
temperature converted to degrees Celsius.

# Allow the operator to use the controller keypad to enter a number, such
as a setpoint, via a Keypad Entry Variable.

Inserting and Defining the Variable

1. Click on the variable in the Variable toolbar, then click on the HMI screen
and drag your cursor to create a field for the display of the variable data.

2. Release the mouse button; a dialog box opens, enabling you to define the
source of the variable data.

3. Select from the features and formats shown below.
Note that this image shows the options for a Standard Vision.

Linearization
Allows you to convert values

To see how to use Keypad Entry Variables, refer to the Indirect Clock example.

Link. Ml 16

- number of digits to be
displayad
- presence and placement
of the decimal point

for display, for example,
Keypad Entry analog values to digital.
Click to enable a value
to be entered from the
PLC's keypad. \;
=
Prevents the display of 17 3 Keypad Eny W Lineaszation | X value
a previous number L ¥ Staet with clea hiekd Display -
Sat the range for a S i Max [100 = /
‘lagal’ number | Min 32768 = Min [0 | ._.r"f l
|| -

When selected, Max [32767 J 4 |_V value
pressing the Up/Down = Op V&z..-:a
keypad arrows ——L_ '™ Up/Down Anows Min 0 | Max 1023 D
increments/decrements ,-_-era Increment: |1
the value by the value
entered here. Ted Alter

: , - = : |Holeadrg =]

MS Sans Sedt (8) [5 = [0 - [Degrees
Display Format — — —! ™ Unsigred fomat
Select font, decimal, text Z M T
& leading zeros. Deseription * [Temperatize | Use these to determine the: | | Unsigned format does NOT

affect the number as it is

|| 'seen’ by the PLC. Salecting

[~ unsigned format removes the
sign from the Display ONLY.

|

Touchscreen-only models (V290, V530)

These models have a 'virtual' keyboard. After a keypad entry variable is
touched on the screen, the keyboard is automatically displayed, enabling the
value to be entered. Note that you can set a font for variable display in Font

Handler.

42
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About the HMI Display and Keypad Standard and Enhanced Vision Divisions

.opens the Vidual Keyvboard,
dizplaying the name of the
variakle .

Touching a Keypad
Eritry wariable .. ..

Enter Password E’;Ej

Notese | \When an HMI keypad entry variable is active, and the Enter key is
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed
turns ON. This can be used as a Jump condition.

* | SB 250, Keypad Entry within Limits, turns ON when a legal value is
entered; SB 251, Keypad entry exceeds limits, turns ON when a value
is out of range. You can use the status of these bits, for example, to
provide a jump condition to another Display. When either of these SBs
turns ON, the index number of the active variable is stored in SI 249.

Note that you can limit the number of attempts by using SI 45 Numeric Key
Entry Out of Limit - Counter of Attempts (Enhanced) to jump to another
Display.

SI 253 the user can change the password (or view it when the controller is On-
Line)

Standard and Enhanced Vision Divisions
Note that there are a number of differences between Vision Divisions.

Keypad SB 92 Keypad Entry in SB 92 Keypad Entry in
Entry Progress (ON during Progress (ON during entry)
Variables entry) (Enhanced (Enhanced Vision)
Vision).. SB 93 Keypad Entry Var
SB 93 Keypad Entry Var Activates (ON for 1 scan)
Activates (ON for 1 scan) (Enhanced Vision)
(Enhanced Vision) SB 94 Keypad Entry Var
SB 94 Keypad Entry Var Complete (ON for 1 scan)
Complete (ON for 1 scan) (Enhanced Vision)
(Enhanced Vision) SI 45 Numeric Key Entry Out
SB 250 HMI key entry of Limit - Counter of Attempts
within limits (Standard (Enhanced Vision) (Counts the
Vision only) number of failed attempts to
SB 251 Keypad entry enter a value)
exceeds limits (Standard If a Legal Entry bit is defined,
Vision only) SB 94 does not turn ON if the
SI 249 Last Active entered value is out of range.
Keypad Entry Var The keypad stays on screen
(Standard Vision only) until a legal value is entered.
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Standard and Enhanced Vision Divisions

Active
Keypad Entry
(SBs)

Keypad
Entry: Focus

Password
Entry via HMI

Entering a
legal keypad
entry value

Entering an
illegal
keypad entry
value

Active
Keypad Entry
Variables
(Sls)

Keypad Vars
Locked

Enter Display
with locked
Keypad Entry
Variables

Enter ASCII
value

SI 250 Currently active
keypad entry
(read/write) (Standard
Vision only)

SDW 10 Keypad entry
variable value

SB 32 HMI Keypad Entry
in Progress (Standard
Vision) rises during
keypad entry

After Keypad Entry, the
next variable set in
Variable Tab Order
automatically becomes
active.

¢ Correct password
turns SB250 ON

¢« Wrong Password
turns SB251 ON

SB 250 Keypad entry
Within Limits turns ON
for 1 scan

SB 251 Keypad Entry
Exceeds Limits turns ON
for 1 scan

SI 250 Last Active
Keypad Variable
contains the number of
that variable

SI 251 Currently Active
Keypad Entry contains
the number of that
variable. The
application can change
the operand value to
force a variable into
active state

Enhanced Vision (V130
only) Turned ON by user

In Ladder application, set
SB30

You can use SI 45 in
conjunction with a Compare
function to exit the variable.

SB 92 HMI Keypad Entry in
Progress (Enhanced Vision)
rises during keypad entry

If SB 76 is OFF after Keypad
Entry, the user must use the
arrow keys to move to the
next variable.

Turning SB 76 on causes the
next variable set in Variable
Tab Order to automatically
become active.

Legal Entry bit in Password
Variable turns ON when
correct password is entered.

SB 94 Keypad Entry Var
Complete + Keypad entry
property: Legal Entry MB
# Turns ON when entered
value is within legal limits
& Turns OFF when entered
value exceeds legal limits

SI 250 Last Active Keypad
Variable and SI 251 Currently
Active Keypad Entry contains
the number of the relevant
DLU.

Turn ON to lock all keypad
entry variables.

Same

Currently Active Keypad Entry

44
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About the HMI Display and Keypad Standard and Enhanced Vision Divisions

How Keypad Entry Variables Work
Keypad Entry Variables enable a user to enter values via the Vision keypad.

In order to enable the user to enter values, the variable must be active.

When a variable is active, pressing Enter 'locks' the variable, and writes
whatever value has been entered from the keypad into the variable. The next
variable becomes active.

Keypad Entry Variable 'Tab' Order

Variable Tab Order enables you to determine the order in which Keypad Entry
Variables will be activated, regardless of their location on the LCD screen.

Note o If Variable Tab order is not set, when the application is downloaded
the variables will be activated in the order in which they were
created. This may create the false impression that the variables are
being activated 'randomly’.

Clicking the Variable Tab Order button displays all of the keypad entry
variables in a Display.

a2 s

! Start-Up Display '3 Yariables Tab Order

“ariables E:l

‘Waniahle 3

\ [0k ]| Cse |

When a Display contains more than 1 variable, using the right arrow key enables
the user to tab from one active variable to the next. Pressing Enter 'locks' the
variable, excluding it from the tab order.

Displays containing Keypad Entry Variables
A Display with Keypad Entry Variables may be in one of two states:

4 Active
The variables are active, marked by a blinking cursor. A Display loads into
this state by default; the first variable, as set in Variable Tab Order, will
be active.

System Status
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About the HMI Display and Keypad Standard and Enhanced Vision Divisions

# Description Value

SB 30 HMI keypad entries completed OFF

SB 32 HMI keypad entry in progress ON

SI 250 Currently active keypad entry Number of currently active variable
+ Locked

When variables are locked, no cursor is present on the LCD.
System Status

# Description Value
SB 30 HMI keypad entries completed ON

SB 32 HMI keypad entry in progress OFF

SI 250 Currently active keypad entry -1

You can load all Displays in a project in the locked state via SB 27, Disable all
keypad automation. If SB 27 is ON when a Display is shown, the user cannot
navigate through the variable using the keypad keys and no cursor is present
on-screen.. V280 users may, in order to enable variables to be activated only
through 'touch’, turn SB 27 ON as a power-up task.

Note o When V290 is selected in Hardware Configuration, SB 27 is ON by
default. When SB 27 is ON, no cursor is present on-screen. This
enables the V290 user to activate any Keypad Entry Variable by
touching it.

You can also load a specific Display with all variables locked via SB 30, by
building a net as shown below. Note that SB 30 should not be used to lock
variables after a Display has been loaded.

ME 1 Dizplay 1 SB 30 .
- HMI keypad .
enlries
— 5 {s)

After a Display loads, you can enable the user to skip keying in data for all of
the variables on-screen, by turning SB 29 ON after data is keyed into any
variable. When a specific Display is on-screen, turning SB 29 ON, locks all of
the remaining variables.

SE 250 Se 29
HMI key entry - Cuirent keppad

within irnits |- jenbiy etz 5B 30.
1 1 Fi S A"
| LI L=

Notes o Regardless of the variable tab order, the user can activate variables
by:

& Touch, if the project is based on a touch-screen controller and
if the touch property has been assigned to the variable. If this
property is assigned, touching the variable activates it, causing
it to be marked by the blinking cursor.

# By writing the variable ID # into SI 250, either via Ladder
program, Information or Online mode.

These methods can also activate 'locked" variables, in which values
have already been entered, or that have been locked via SBs 27,
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About the HMI Display and Keypad Standard and Enhanced Vision Divisions

| 29, or 30.
Relevant HMI SBs and Sls

To see the variable ID numbers, open HMI Information from the View menu
and click the Variables tab.

B HMI Information

[VModueName —[Display Flame [ 1 290 [ Vasabie Naroe |3
0 Vaisble1

Wariable 2

‘Wasiable 3

Waiiable 5

‘Wariable 12

Waiiable 13

Wariable 14

Wariable 15

‘Waiiable 16

Wariable 17

Wariable 18

Waiiable 19 b

| Statt-Lip Display

1 Start-Up Module

Fillrig system

ol TN e G P = O LD o =

Touchscreen models (V290V280)
There are 2 types of Vision touch-screen models:
#* Models which comprise only a virtual keypad (V290). In these models, the

virtual keypad opens whenever the user touches a keypad entry variable
that is currently displayed on the screen.

[ Enter Passwoard ]

DA D
1|12]|3|4]|5)6]|7]|8]2]0
QIWIEIR|TIY (U]l |O|P
AISIDIFIGIH]|J |K]L |+
Enter Password ESC |Z|x|C IV IB N M|
ciear i | [&-|-0]| Space |4 | )

-

o m

. =)
[}
T
)
i)
(4]
-
[w]}
9
o

%

WL pritronleg

=~
ﬂﬂ@l
[-1-]

# Models which comprise both an HMI function keypad and a virtual keypad
(V280). However, in these models, the virtual keypad must be activated
by turning SB 22 Enable Virtual Keypad ON (Note: SB22 is relevant only
to Standard Vision + Touchscreen, not Enhanced) This must be done at
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power-up, or before the Display containing the keypad variable is entered.
In addition, the Keypad entry variable must be assigned a Touch Property.

After a keypad entry variable is touched on the screen, the keyboard is

automatically displayed, enabling the value to be entered. Note that you can
set a font for variable display in Font Handler.

Enter Password

Notee | \When an HMI keypad entry variable is active, and the Enter key is
pressed on the controller keypad, SB 30 HMI Keypad Entries Completed
turns ON. This can be used as a Jump condition.

* | SB 250, Keypad Entry within Limits, turns ON when a legal value is
entered; SB 251, Keypad entry exceeds limits, turns ON when a value
is out of range. You can use the status of these bits, for example, to
provide a jump condition to another Display. When either of these SBs
turns ON, the index number of the active variable is stored in SI 249.

System Bits, non touch-screen and touch-screen Vision PLCs

Certain SBs are only relevant to certain controller models, those with touch
screens and those without. Note that the V280 contains both touch-screen and
keypad.

Which variable is active? Models with
keypads

In these controllers, a blinking cursor marks
the active keypad entry variable. This
cursor indicates that the user can begin to
enter a value via keypad.

The user navigates through the variables by
using the directional arrows on the keypad.

Note that the V280 keyboard is
enabled by default. The
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Standard and Enhanced Vision Divisions

information here is relevant
when keypad entry variables
are not assigned touch
properties.

el Ay A blinking cursor marks an
active kevpad entry
m variable

B Lsion ] 20°

[T varl 1

War 2

- Yar3 0

Pl |
[ ]

wl itranics

Controlling the cursor
via SBs

SB 30 HMI keypad entries
complete

¢ Use SB 30 to run ladder
tasks that require data
entered via keypad.

+ Note that when a
variable is active,
pressing the Enter button
on the keypad signals
that the user has finished
entering the value.

@ After the Enter button
has been pressed for all
of the variables in the
current display, SB 30
turns ON.

"% Vision 120 -

29 | 0 | Cument keypad entry sets 5B 30 (HMI keyp

30 | - HMI keypad eniries completed
| O |Reld L LCD screen dizplay vanable:

After the uzer prezses
Enter for each variable, SB
30turns OM.

SB 31 Refresh current LCD
screen display variables

# UseSB31to
immediately re-enable
data entry.

+ Turning SB 31 ON
restores the cursor, and
re-activates all keypad
entry variables in the
current display.

To re-enable the
vatiables and
restore the cursor,
zet =B 31

SE 31 - Relresh
cument LCD | !

e dienlaa

[«

| 0 |Cunen keypad erty sets SB 30 [HMI keypad
|0 | HHI keypand enibives Comprheted
| 0 |Refresh cument LCD screen display varizbles

\E el

SB 29 Current keypad entry sets SB 30
& Turn SB 29 ON after data is keyed into any variable, to enable the user to
skip keying in data for the remaining variables in the current display.
«+ After SB 29 turns ON, SB 30 turns ON as well.
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..Heactivates all
remaining variables,
refreshes their display
and removes the

If there are active
keypad entry ..zetting B 29
variahles ...

Varl §

SB 29 -Curernt = Va2 111
keypad e s=te | ge7 | Va3 1M
— — |l

5B | 29 | 0 #Cunenl keypaderty sets SE30(HMIkeypad 5B [ 29 | 0 | Cumesikeypad entiy sets SB 30 [HMI keypad

5B | 30 | O |HMI keypad enliies completed SB [30 |1 1H!¢‘I'I' keypad endries completed

| 0 | Refiesh cument LCD screen .ispl_ap vanzbles 5B | A | 1] | Refresh curent LCD scieen display vanables
-l Ifd" | k ﬁlﬁ-‘ |

SB 76 Keypad Entry: Focus (V130 only)

If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move
to the next variable. Turning SB 76 on causes the next variable set in Variable
Tab Order to automatically become active.

Touch-screen only ( V290)

The V290 does not have a physical keypad. When
V290 is selected in Hardware Configuration, keypad
entry variables must be assigned a Touch property.
Then, when a keypad entry variable is touched, a
virtual keypad is displayed on screen.

Note that in a display that contains keypad entry
variables, the variables are not marked by a blinking
cursor. The programmer must include a clue to inform
the user as to what part of the screen must be
touched.

In V290, SB 22 Enable Virtual Keypad, and SB 27
Enter Display without active Keypad Entry Variables
are ON by default.

¥ Vision 290 -

m M Enter “alues,
Variakle 3 press Enter

Yalue appears
on SCcreen

Touch to open the
Yirtual Keypad

SetPont1 5 |

SetPort1 [0V _|
SelPort2 0 | est SetPoint2 B |
6" —
&g’
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Touch-screen and keypad (V280)

The V280 has both a physical keypad and a virtual
keypad.

Physical Keypad mode

If you include keypad entry variables in your displays,
by default, the V280 functions like other Vision models
with physical keypads. A cursor indicated keypad
entry variables, and the user enters data via the
physical keypad.

Physical Keypad mode + Touch

If you give Touch properties to keypad entry variables,
a cursor still indicates active variables; however, you
can page through these variable by touching them on
the screen. The user enters data via the physical
keypad.

Physical Keypad mode + Touch + 'No Cursor"
You can cancel the blinking cursor by turning SB 27
ON. This also means that the user can only page
through the keypad entry variables by touching them.
Pressing the physical keypad arrows will not page
through the variables.

Virtual Keypad (V290) mode

Turn SB 22 ON. When this is done, the V280 will
function just like the V290 describe in the section
above,.

Clock Variables

Place Clock Variables in Displays to show times and dates. In addition to
showing RTC values, use Clock Variables in conjunction with Indirect time
functions to enable an operator to set times via the controller keypad.

A keypad-enabled Clock Variable accepts a number entered via the controller
keyboard, and stores the number in the operand linked to the Variable.

Start Time: hhomm

End Time: Hhmm

Inserting and Defining a Keypad Entry Clock Variable
1. Click on the variable in the Variable toolbar, then click on the HMI screen
and drag your cursor to create a field for the display of the variable data.

2. Release the mouse button; a dialog box opens, enabling you to define the
source of the variable data.

3. Check Keypad Entry and select the format and display font.
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1| ®ariable: Time Functions x|

H 4 Text =&t Image * Murmetic *i_;': Clock =&l Timer -
Select format: | Select

Hour [CT]. [ Keypad Entry.
_ [\T — Format
h]

Namme the |HourCT) =l
Yariahle.

Mz Sans Senf (3] = F.enpad Entng
| = | . Vs RemadEni

Link the Yariable
| ?E:Sl:riplil:ln : IStart Time ko bl 30
| Link : kdl 300 : Start time %l (] | Cancel |

Step-by-step instructions on how to use Keypad Entry Clock Variable
values are provided in the Indirect Clock function example.

Note o

Clock Variable: View\Enter RTC\UTC Values
The Real-Time-Clock value in the controller can be shown in a Display.

Inserting and Defining the Variable

# Create a Variable field and select Real Time Clock, then define the
Variable by selecting the time format and display font. You do not link an
operand because this variable is already linked to the RTC.

Note o | Only full format variables, hh.mm.ss can be set as keypad entry.

UTC Variables

Placing a UTC variable displays the value of the linked operands as an RTC
value.

‘04 21:18:04
Online Test
» m (=G
3| Variable: UTC X
% Text '@fj Imange '@ Mumeric =BT Graph 't;'; Clock =& Timer =080 Counter =
S
— Drate Format Time Format

| DD MM Ay -] [HH:MM 55 | W o Keypad Enty

— Font
M5 Sanz Senf [8]

Dezcription : [V ariable 1
Lirk - D' 5 [ Ok,

Cancel | Help |

[nputs e e z Format
[rouble Ywiord

ow | 5 | | | 3304531084 | DEC |
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Note that if you select to display SI 30, the variable will display the full RTC
value.

Keypad Entry

On the screen, the variable is shown in Time format, according to your
selection.

+«+ DW

The 32-bit binary number contains the UTC value in seconds, where
1900-01-01 = 00:00.00 UTC.

« SI
To set the RTC from the HMI, link the UTC variable to SI 30; the value
entered via keypad is written to RTC system operands SI 30-34.

+« MI
Linking an MI causes the UTC value entered via keypad to be written to a
vector of 4 MIs, where the selected MI is the start of the vector.

List of Texts: by Pointer

This type of Variable contains numbered lines of text. You link the Variable to
an operand. The value within that operand 'points' to the number of a line
within the list. When the operand value is equal to a particular line number,
the text of that line is shown in the Display.

Line Humber
The text on a line is =
linked to an numeer .

.1

2y

—| Under Min. Limit

Operand 'Pointer’ —|vithine Limits
The linked operand

‘pairts toa line.

—[Crweer Max! Danger |

[ escription : |P'ressure Level
|MI 100 Pressure Level

Variable Field | E E S I-'I r E

When W00 contains

‘2, Ling 2 "Ower hsd l'|'. E I:

Danger' will bhe shovwn .

‘-\

Crver Max! Danger

Inserting and Defining the Variable
1. Create a Variable field, and then select List of Texts: by Pointer.

2. Define the Variable by entering lines of text and linking an operand.
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fariable; List Of Texts

ot~ {or Image ~ [ £:- Clock =4I Timer =33 Co

Over Mad Danges

M5 Sans Senf (8]
M5 Sanz Senf (2)
MS Sans Se.

[ within Limits
2] O Mad Dange:

[ % Keypad Erty

| = nsert Before) | % Delete Index: 2

&= “ppend

Desciiption : |Pressure Level
Link - 1100 : Fressure Level

ok | cancel |

|

By using the Keypad Entry Option, you can also enable the user to
select a line using the Up/Down keypad arrows.

Note o

The Keypad Entry option is not supported for Touchscreen-only models
(V290).

List of Images: by Pointer
This type of Variable contains a list of numbered images. You link the Variable
to an operand. The value within that operand 'points' to the number of an
image within the list. When the operand value is equal to a particular image's
number, that image is shown in the Display.

3 Variable: List Of Images

L?:ﬁ;:;?ﬂnked 84 Tewt = {08 Image - [0, Mumeric =1, Clock =& Timer = 68§ Courver =
to & number in the !
Lizt of Images . List of Images
The number of an &  append Biowse .
image appears
underthat image. T nsert Before 4] *®
3

Keypad Entry =2 Feplace Index: 4 %,
Thiz enables the user
to maove between ﬁ J S8 Delete Index: 4
images by pressing
the keypad's Up/ 4 S image: [ Bx 3~ GhxdB
Do arrowy kevys.
Each 'Up arruwﬁess' % GRS
increments the linked
regizter; a 'Down W) ign - [Val
e [T TN | oo | e |
el S Operand Pointer

The value of thiz operand determines wwhich image inthe list is displayed.

For example, when M0 cortainz 4, Image 4 iz displayed.

Notee | By using the Keypad Entry Option, you can also enable the user to

select a line using the Up/Down keypad arrows.

The Keypad Entry option is not supported for Touchscreen-only models
(V290).
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Inserting and Defining the Variable
1. Create a Variable field, and then select List of Images: by Pointer.

2. Define the Variable by adding images to the List of Images and linking an

operand.
List Manager
U=ze the buttons to:
- Include the image showen inthe Previess pane in the list Openthe Image
- Edit the exizting list by =electing an image in the list, Library, locate
then uzing the buttons to make changes images, then add
\\/ them to the list
7
= &=  Append Browse ..
Click to = |nzert [Before 4] »
zelect an _
image = Heplace Index: 4 iy
S8 Delete Index 4 AN,
| Click to open Microsoft
= | 5 Imagss. | 45231 == B4 =M paint, create an image,
™ 3 Keypad Ertry then save and import it
inta your project
Descopdion : | al
Lk : W0 vVallewel ™ | Cancel | Heb |

List of Images: by Range

This type of Variable contains a list of images. You define a range of values for
each image and link the Variable to an operand. The value within this operand
is compared to the range you have defined for each image. When the operand

value falls within a specified range, the image assigned to that range is shown
in the Display.

d Yariable: Range OF Images
o Tedt =358 Image = [T Mumeic = £,: Clck =20 Timer = &F Counter =

HS

& Apeend | Ml 11 : SesPiri

Ml 11: SelPoint 42
— 43

= |ryzert [Befoue]

I Delele Selected

Dasciiption : [Incubabor Temperature
Lnk. | [kl 10 Incubstos Selport A 0K I Cancel I Help |

Incubator T emperature

|hicubator
T emperature

Note that you can define the beginning and end of a range using either a
Constant value or an MI.
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Inserting and Defining the Variable
1. Create a Variable field, and then select Range of Images: by Pointer.

2. For each line: define the beginning of the range, the end of the range, and
assign an image.

x|
o Tewt =
=  Append I 111 ; SelPainit
2
= Inzat 4 hc

i select value For Low Range EI

B ﬂmlﬂ.ﬂmwﬁl

[ =1 [SetPoint (=l
K| = | JoEC x| T g Heb |

Graphs: Displaying Values
Bar and Shape graphs can be used to show how values progress. You can use
them together with other Display elements to help operators track system

progress and status.
This is a sample of an HMI Display and how its elements can look on the
controller's LCD.
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Bar Graphs with
borders...

Uze text boxes to label the graph .

ook like this on

“JZ unitronicg # Vis/ om0

Notee | Vision controllers also support Trend graphs

Inserting the Graph

1. On the HMI toolbar, click on a Graph icon; then drag the cursor across
the controller screen to create the graph object.

2. Select the appropriate options. Graph options vary according to the Vision
Division and HMI Display type.

Defining the Graph

Standard Vision: V120/230/260/280/290 Monochrome
Bar graph
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1| ¥ariable: Bargraph Il

. i-- | et minimurn and i
iraction i Iage - mMumeric 1.~ ' Click here to place
Select the direction in o 1., SETTT Wl T oo e

display. the bar.
HDhire T \\_\J y
ki |EI i

nﬁ . ﬁ: (|

b L * e \g. L bl & I'II:IEI v

which the bar will grov.

Description : [\ ariable 10
Link : ]ML 34 Incubator Temperature gl OF. | Cancel |

Link the opetand whose valle
vou seant to displasy.

Shape graph

Variable: Shape Graph

ext *Eﬁ Image *@ Mumeric = B Graph 'ﬁ'; Cl " Counter -

* Gauge " Tank

Fioht il Min I

& O m T

Deszcription : |"-.-"aria|:||e 4
Link. - |I'--1I 1

k. | Cancel | Help |

Enhanced Vision
Bar graph
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3 Variable: Bargraph

Direction

= hf =

Min [D# 0 J
Max [D# 1000 J

Drescription : |Varial:ule 4 Drezcription Fomt: I ;I
—Linksz Colars
Lirk; ML D - link to bargraph Back Color _
Hide: [ME 1 - hide bar graph []| [ e
Disable view: | _I QI o I ;I
: : Text
P arking wew:l _I QI .-“-‘-.Iignmentl ;I
Legal entry: I _I QI Style: |3D [Corees] ;I
Touch: |ME 3 - touch graph _I QI
k. | Cancel | Help |
Parameter | Type Function
Direction Selection option | Select the direction in which the bar will grow
Min/Max Constant or Sets Limits
register
Fill Color Selection option | Click to open Color pallet and select a color for the bar

Meter graph

Click the tabs to configure the appearance of the Meter.

d Yariable: Meter

arc | Neede | Ticks | Label And Background Ranges |

Min R

M oo 10
DistanceFromuc <[ [ »|0 |gg
Color |

R Have Borders [ = Append

| = ircen (Before) | S Delete Selected |

Tab Function
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Arc Click and drag the slides to adjust the Radius, Arc Angle, and Rotation
Needle Adjust the appearance of the needle
Ticks Adjust Tick length and thickness
Label And Edit the Meter name, and select a background color or image
Background
Ranges Assign colors to different sections of the Meter's Arc

Tank graph

i g
3 Variable: Tankgraph
- Tanks Parameters
Uri_Tanks Fil \Wide 11.EMF O T ——
Uni_Tanks_Fil_Wide_3 EMF Max (D100 J |— Fil Coloe
Parameter | Type Function
Tanks Selection option | Select the tank type
Min/Max Constant or Sets Limits
register
Fill Color Selection option | Click to open Color pallet and select a color for the tank

If the background color is displaying incorrectly, note that a tank object should
not be placed on a white background. In this case, certain tank objects might
be partially framed in yellow frame. Any other color may be used. In addition,
note that changing the background color of the display does not change the
background color of the .emf tank graphic.

V290 color, V570

Trends
LEDs

The bars in a LED graph represent a changing value in the same way that the
lights of a stereo equalizer represent the sounds. You configure the number
and color of the LEDs in the graph.

60
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3 ¥ariable: LED Graph

Mumbet of LED: [
Min Walse 1
Max W alue
: o On' Co |
LEDs Preview | |
Fiois Colox == |ngert [Before)
“ - o —— —l
60 o % Delele Selecte |
Desciiption : [ariable 1 I =
Links Colors
Link: MG | Back Color [
Hide: | J g Properties
| il | = -
| =l Z =
[ _I _xl Stde: 3D [Concave]
Towh | .| &
ok | Cancel | Hew |
Parameter | Value
Number of Maximum number = 32.
LEDs
Min/Max Depends whether the link is to a single or double register; for example MI range is

32768 to +3276; ML range is -2,147,483,648 to +2,147,483,647.

LEDs Preview

Use the slider to check the appearance of the graph.

Fore Color Click to edit the color surrounding the LEDs.
Direction Changes the orientation of the graph
From Assigns the number of LEDs to the value range.

For example, the following image shows that the low range assigned to Green is 0-
30, there are 3 bars assigned to that range.

U0 3 variable: LED Graph

Mumber of LEDz  |1p uEEchon
Min Value o gm f « & C -
Max Yalue 100
A
LEDs Preview  + J_-| E =
Fore Color | | -lEI == [nsert (B
60 E— 0o
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Note o The minimum width of a LED bar is 2 pixels, and that the space
between bars is 2 pixels. If the height of the graph is not evenly
divided by the number of pixels used by the bars and spaces, the
remaining pixels will be colored as the Fore Color.

Properties
HMI Object type: Variable | HMI Object type: Variable

Position Pasition

Left 16 Left 16

Top 19 Top 19

Wwidth 50 Widh 50

Hesght 204 Hei 170 |
Assign/E dit Assign/E dit

Touch i <Mouse Click> Touch ! <Mouse Clicks

Thermometer

Represents a value by changing the level of a thermometer icon.

3 Variable: Thermometer Graph [?l
-+ 39550 [B

Min [ Background Color [l

M Bz J Fiore Colos [ |

e MaorTicks [ M 6ol Cotor [ |

MinorTicks [+~ |

"""" Description : | Temperature Dezcription For | j
~ Links Colars
+3993¢ Lirike: P«'Il 200 - Temp input _l Back Color _

e view iz Fcnt [MS Sans Seif(g) =]
e | _| 7] swe [0 (Pessed ]
ok | concel | Hep |
Parameter Value
Min/Max Depends whether the link is to a single or double register; for example MI

range is 32768 to +3276; ML range is -2,147,483,648 to +2,147,483,647.

Ticks Change number and color.
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Trends

A Trend graph displays a dynamically changing value graph that tracks a
single, dynamic value such as a temperature value, as a curve on the Vision
screen.

Note o Trends (Legacy) Function Block
If your project is configured to Standard Vision controllers that do
not support HMI object Trend graphs, the Trend objects will not be
displayed in the Project Navigation Window. In these models, use
the Trends (Legacy) Function Block.

Trends are displayed in the Project Navigation Window. The number of Trends
and Curves that can be displayed depends on controller model:

« V570/V350
Up to 8 Trends, each displaying up to 8 Curves

4« V130
Up to 4 Trends, each displaying up to 2 Curves
Each Curve may be linked to a different register, and can be configured to a
different color.

Trends have a default touch property that causes a touched Curve to be
brought forward. In the following figure, the Temperature curve is in front.

Touch the Mode button to toggle between:
+ Run Mode:
Shows the Trend being drawn in real-time

¢ History Mode:
Stops the Trend, displays History Scroll buttons; touch these to scroll back
and forth between different Trend graph sections
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‘M’ : Togale between Online and History Mode
‘G': Teggle a background grid on and off

Temperature

+100-

Dmgll aties M / /
= m Trendi : I \ /4_--—-/
. T ernpet stune P A
X Prezsure >
x T ] }
Operand MI 2 \ ~
Y Mirc -100
¢ Masc 100 100 - _/1 :
e L w l » | 110607
t Curved EELGJPJ 5957
Curveb |
Eﬁ; Histary Scroll

V130

In Histary Mode, scroll according fo
Trend Properties settings

Laft: the oldest Trend time in view
Right: the most recent Trend time in view

Since the V130 does not offer a touch screen, you use the Keypad arrow
buttons to enter and navigate through History Mode

Enter History Mode

Up arrow

Exit to Online Mode

Down arrow

Scroll through History
Creating a Trend graph
1. Define a Trend:

Left and right arrows

Right-click the desired Trend to open and set Trend Properties.

= @ Trends T Trend Properties @
- Tiend? | Properties Hame
Ll | [Temperature
+ Trerdd P .
¥ Tiend5 | Find Trend : Trendz s .MT ol
ampling [ntery. 00: 0D: 700
: *;'::i &P Clear Trend : Trend:
L - —————] History Samples 1000 50 to 16000
Rlun/Stop MB weo .| &
Cancel I Help |
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Property Function
Name Assign a unique name to the Trend.
Sampling Interval Defines how often the Trend draws Curves, resolution

= deciseconds (0.1.)

History Samples Total number of samples that may be stored in History
for ALL Trends is 32000. The minimum number that
may be allocated to a Trend is 50.

To view the total History Allocation,

right-click Trends in the Project Navigation Window

=
=1 ik Tien
Trend2 500 1 = 500
Number of total allocated history points ~ [600
Mumnber of total free history points [pram
0Kk | Concel | Hep |
Run / Stop MB 0= Stop
1=Run

Status rises from 0 to 1:

e The PLC begins to draw the Trend Curves

* The History is initialized

« 'Run' is displayed at the bottom of the graph

Falls 1 to O

* Trend freezes

* Under can press Mode button to enter History and scroll through
Trend

» 'Stop'is displayed at the bottom of the graph

2. Define Curves
Right-click the desired Curve to open and set Curve Properties.

= [ Teends
- %T:rnuj‘. Prop
O Ll Curvall Tp—
- El_n'\.'tl EE Eg Tedt |D el
+ e
Cuvey S String from Library [<Mouse Cic|
¥t Curve &P Cear Curve : —
Data Opesand (MI)
100 m—
100 —
[+« <o
Cancel |
Property Function
Name Assign a unique name to the Curve for display on the
HMI screen.

You can also use the String Library. The string you
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select will be displayed as the Curve name on the HMI
screen; however, note that the string you select will
not appear on the Project Navigation tree.

Data Operand This is the value represented by the Curve

Y Min, Y Max These define the axis range for that Curve. Note that
you can also set a decimal value.

Once you configure a Trend and at least a single Curve, you can place the
graph in different HMI displays and set specific properties for the Trend in that
display, such as the Trend background color and Curve colors.

3. Place a Trend Graph in an HMI Display

a. Click the Trend icon on the HMI toolbar, and then drag the cursor across
the screen to draw the Trend.

“HE
S image

w3 i
K

b. Release the mouse button, and define the Trend Variable properties.

Note o Under Links, note that the Link MI shows which Curve is currently
forward
# V570 1= Curve 1, 2=Curve 2, etc. Therefore when the MI
contains 3, Curve number 3 will be forward

# V130:2=Curve 2. 1, or any other value causes Curve 1 to be
forward

66 VisiLogic: HMI Applications



About the HMI Display and Keypad

Standard and Enhanced Vision Divisions

Amea-m [Caves |
Atachto [Trend El Fide cuve
. Temperature H
Ports to display  [53 7] i Colo r P C
Humber of ¥ icks [g Buttons Cobos | | Tirra

Numberof ¥ ticks [§

History scioll mode [11a8 of screen ~|  Grd Color - £ Clear Operand |
[+ Diaw ines between points Date Foemat ddimendy
¥ Change curent Curve on touch Descrgtion . [Kin 1 Drwncogd
o Lirks
Description : (K 1 | e F‘ ;I
Links Colors
ik id | sckcoo NN Mee =2
Hide: | | 7| | Propeties Do v | =l
Disable viewe | .| 2] =1 | kg v =&
I _| 2] s [0 iconcavel Touck | Az
I o
I Cancel | Help | |
Tab Property Function
Appearance | Points to Display Sets the number of actual points that will be shown on the
screen at any one time
Number of X ticks, Y | Set the number of gradations on the axes
ticks
History scroll mode Sets the paging size for History view
Draw lines between If this is not selected, the Curves will be drawn as a series of
points points
X Axis Color Note that the Y Axis color always changes to match the Curve
than is in front
Buttons Color Sets the color for the Mode, Grid, and History Scroll buttons
Grid Color Set the color for the background Grid
Change current Checked by default. Curves have a built-in touch property
Curve on Touch that causes the touched Curve to be brought forward.
Curves Color Click to set a color
Hide Curve if you assign a Hide Curve MB, turn it ON to hide the Curve.

Note that the Link MI determines which curve is forward. In the case of the
V570, touching the curve writes the curve value to the MI, bringing the

touched curve forward.
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Trend from SD

Note that you can also display a Trend Curve from the Trend History that is
stored on an SD Card. The parameters are the same as in Variable: Trend,
given above.

< Variable: Trend from 5D E
(L

Appearance | Curves |

Flanames; [MI 0 J Trend boad ernor bt [ME 1 |ZI
Foider [Fe00 - TRENDST __|

Poirds bo dizplay [EI] ~| ¥ Az Cobor [

Mumbes of < ticks |5 Buttons Color B

4. Control the Trend by toggling on the Run/ Stop MB assigned in the
Start and stop the Trend as shown below.

ME 5 ME 0[5]
Control Trend - Trendl
Run/Stop
I (x)
To learn more about Trends, check Trends - Color Vision.vlp in the Help>
Examples.
# Description Value Comments
SI 63 [Maximum number of 0-64 e Initialized at Power-up.
Trend files that can be  |The maximum amount of |« ypdated when:
saved (read-only) Trend files (*.utr files) in a - when SB 217 is ON

single folder is 64. The - when Trend file is created.
value in SI 63 shows the

number of remaining *.utr
files; if 5 *utr files exist, SI
63 =59

SD Card Browser

Placing this variable on screen enables a user to press a button to display all of
the files in the specified folder.

& Touch Screens (V570/V350): The user presses the Browse SD on-screen
button. If file selection is enabled, the user touches files names to select
them.

¢ Non-Touch Screens (V130): The user presses the Enter button, and
navigates between files using the arrow keys.

SD Ladder Functions enable you to read/write data between an SD Card and
PLC memory operands, including blocks of file data, Data Tables, and Trend
data.

You can also enable the user to delete files, or to copy the file name to an
operand vector. You can control whether to display the Delete button by using
the Hide Delete File MB.

Note o | The SD Card Browser only displays file types that are relevant for the
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requested folder. For example, when you view DT files, you will only
be able to see .udt and .fdt files; if there are other files in the folder
they will not be displayed.

In the Web folder, all file types are displayed

Note that in VisiLogic versions earlier than 8.0.46, EXCEL folders
cannot display .txt

files. In addition, PLCs running an OS earlier than 3.0.59 do not
support .txt display.

< Variable: Browser 5D content

This vanable creates a ‘Browse 5D Folder button that shows the fles in a specific SD lolder. ou can diplay
buttons that enable the user to delste a fle from the SD, of to wilte a file name to a vector

B Bution test
The uzer prezses this bulton to open the Browese SD wandow ™ Sting from Tesxt Library

& ContotTet (RNSOCH oo W

L Browse SD window

Configures the browser window: the bithe bar, buttons in the window, and the folders that se
chsplaped in the broweser,

¢ rmes SO ( SiwafonTed iy

@ BaFont  |MSSarsSert(8) | TetCoor Bar Cor: [
Ll Folder to Display File Name Font

D% 100 -DT1100) - | |MS Sans Senf (8] -
Change the = =
appearance of Hide Dalete Fils butten [ME 0 - Hide Delete Fie button =i
the Title Bar % Show Send File Name to Vector button

Select Vector [each iegister byte contains one ;
chasacter of fie ) [MI D - SD Fie Name » Vec [Stan of Viector) J

File Name to Vector Success Bit [ME 1 - Success: SD Fie Name to Vector J

Description : [Variable 1 -

ke Coloss

Back Codoe
Select File
Willie. txt

Files in

v

Moving Image
This type of variable displays a moving image on the controller's LCD screen;
the image moves according to the value of the linked MI. This feature is only
supported by the Standard Vision Division
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mDSES? I BN BN
ma pulse NC b
g 2

Bl i b1 1

¥ Vision 280 -

PR

Note that all of the moving images in the above picture are linked to MI 1.
When MI 1 holds 0, the images are at the start of their 'containers'. When MI 1
increments to 1000, the images are at the end of their 'containers'. The
'‘containers' set the size of the field in which the image can move. The range of
movement for the field is 0 - 1000--no matter how long the field is.

I Start-Up Display

< Variable: Moving Image
S04 Test ~{5f Image - [, Numeic ~BIC Graph -1, Clock - &I Timer - 8§ Courder =

i

Direction

& i
b

t
-

Select Image

Description : [Vansble 1

Link. : M1

List of Texts: by Range

This type of Variable contains lines. You define a range and enter text for each
line, and link the Variable to an operand. The value within this operand is
compared to the ranges you have defined for each line. When the operand
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value falls within a specified range, the text assigned to that range is shown in
the Display.

d variable: Range Of Texts |
g Tewt % Image - i Mumeric *i_;'; Clock -k Timer - Ect

=
rE7i

Termperature Naomal ;I

E| Toa Cold! Arial £10 )
= e Al (10

33 42

[ Tow high! Arial (10 U3 :I
. [
Whenthe Yalue in MI20)
i betwween 33 and 42 =§ I E I
D escription : [Coap Temperature _

—I IIMI 20 Current Temperature | Ok I Cancel |

Coop Temperature

Coop Tempersture

o Temperature Mormal'
is showen on

lemperature MNaormal

Note that you can define the beginning and end of a range using either a
Constant value, or an MI.

Inserting and Defining the Variable
1. Create a Variable field, and then select Range of Texts: by Pointer.

2. For each line: define the beginning of the range, the end of the range, and
assign text.

cliet s Clack =L Timer A Tuke the

FEs0n tasd biars

text

Select Operand And Address k|
|EE| Drect ||5fg, Const |
L 1

To =et the beginning
of end of & range:

- Zelect an Ml
e S Ok
- Frter a Constant wali= Iﬂ j IE I EI _I
Canzel |
© | |oEC =
@ EIKl Eencel|
3. Use the Add Line buttonil and Delete Line button = as

needed.

String Library
Use String Library to store text strings within the controller's FLASH memory,

and then display them on the controller's LCD. You can, for example, organize
text into different String Libraries—for example, separate libraries for Spanish,
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English and Italian—pull strings into HMI objects, and then switch libraries to
change the display language.

These strings can be displayed in the following HMI elements:

¢ Frame

& PButton

# Fixed Text
String Libraries also provide the text for Alarms, and can be used in Trend
Curve Properties.
There are:

# 16 String Libraries containing up to 1024 strings each. You can change the
library default names.
Via String Library> File, you can opt to use only 4 or 8 libraries; in this
case the total number per library is 2,046 strings.
Note that each library contains sections in the 3,000 range, that are
‘greyed’; these are reserved for system use.

¢ Each string can contain up to 128 characters.
The total memory capacity for all String Libraries is 64K.

L | This feature is not available in Standard Vision controllers.

How String Library works

Only one library is active at a time. This means that at any given time, all
elements that pull text from a library are using the same library.

However, each HMI element may be linked to a different line ID # within that
String Library.

In the following figure, the buttons are linked to different text lines. Each time
a different String Library is called, the button text changes.

% String Editor

e @ 3 X Font: Verdana(i1) -

© String Editor
@ [ X Foot: Verdana(11)

= D 3D
& @ @
— -
L1 Il 1 ]
- @ 0
[

@

| The button on the left is linked 1o Text line ID 0 ]

The buiton on the right is linked to Text line 1D 1 Jl

Configuring Strings
1. Click the String icon on the navigation tree or toolbar to open the Strings
editor.
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Project Edit Wiew [nsert Buid Connection Ladder HMI Jooks Help
DS & BPRlxlol = &R gEﬁﬁ@v'ﬁﬁ & @ @ ] @ | DiectConnection » | 2
' lwr IR I07 |4 z - Wi e LIE & =] i £l i el o] LB LTE LA a Properties...

D )S‘ fts’rru Libsasy

¥ String_Library_1
"8 Sting_Librany_2 E
8 Stiing_Librany_3
¥S* Sting_Library_4
Y8 Sking_Libeaty_5
| & |
| B |
[ 7]
| 8 |
g |

£

[pouble-click row to adi String|

8 Sting_Librany_6
*S* Shing_Library_7
Y8 Shing_Librany_8
& web Service
= () Data Table:

0K Cancel

2. Click on File> Rename Library to assign a unique name to the Library

-3 String Library - Configuration

Letters 1

Symbols_3 & HMI String Library
Stings_Stosage 4 |

Shings Storage. 5 Enter Library Mame [English letters only)
Shings_Storage_b |H ehiew
|Str'ngs_5tuags_?

| 0
[ 1| _
Stl'-I'ES S'IIEQE g
string_Lirary_d |

3. Double-click on a row to open the String Editor.
Note that the String Editor opens strings according to the ID #. In the
following figure, the first three messages are displayed for String Libraries
Letters_1, Numbers_2, and Symbols_3.
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ﬁﬂlrfngs Library - Editing
Fie Stings Help

Symbolz_3

Stings_Stotage_4
Stingz_Storage_ 5
Stongs_Storage_B
Strings_Storage_7
Shings Storage 8

|
|
_—
=
_—
-
_——
Y

Stringr,-_Sh:nrage_E

3. Place your cursor in the desired String Library row, and type in text. You
can also include indirect text from an MI vector.
The text is displayed in the PLC Preview window.

© Siring Editor

T @ BLX Fort: M Sens Sert (8) IR X A8 %,

]

) 31D [riceqt Indhrect String |

o I Gk O
T om0
= & W O
& m’awn
W W O

Slrnir::Sl-:m-;u:ﬁ

Stongs_Storags_T B Indirect String
[Stgs_Stawage 8

Hobe

[Each character will be stoted in & singhe bybe
PLC Screen Prevew

Start of Sting : M1 100 - Hame |
Stng length : |8 =l

0K | Concel |

nw

Display, 03030309 o
5|
6 |

L=J = = =} = 3 =it = I

Ok | Cancel | Hep |

You can also break text lines by including Carriage Return + Line Feed
characters.
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B String Editor
@ﬂ? [3* X Font: MSSans Serif (8) - X v‘ %
Insert Carriage return-linefesd |

a4 a a
1/1|1
1
:.I|_||_J'_|||_-|||u:_:'. h e | [ |
Stings_Storage 5
Stings_Storage_B |
Shirgs_Storage 7
< B B »
PLC Serean Preview Irifa
Shireg at 1D: 0 Char index 1
Sting uzes 12 of 127 characters
[ [ Storage Memoy Usage | % |
0
H 0
hello 0
world 4 | 0
4 E 1]
[ | 0
7 | 0
[ 8 | 0

OK | Concel | Hep |

Note that you can find Unreferenced Strings via the binoculars icon on the
String Library toolbar.

Importing/Exporting Strings to/from Excel or .csv
These tools are located on the String Library File menu.

1] Excel: you cannot create an Excel file and import it. You must export a
String Library from a String Library, delete any undesired information,
and then enter your own strings.

.CSV: you must use a delimiter that does not appear within the string's
data, or the values will not be separated according to expectations.

Import/Export from Excel
1. Select all of the Strings in a Library. and then select Export
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B String Library - Configuration

a
b

=]

Fila Strings Help

ho@ @AM E 44 B4 | Cusrent Libray: Sting_Library_1 -
Stings Select All
ER Shing Contert
[ 0 | 5Dec
L1 E-Dec
TDec
8Dec
| 4 | Hoec
| 5 | 10-Dec
| & |
| 8 |

2. From the File menu, select Export to Excel.

B String Library - Configuration
File | Strings  Help .
Rename Library rF &% B Curend Libeary;,  Sting_Libeary_1
Mumber of Libraries 8 8
I/ Equrt selection to Excel
& Irtgort From Excced

3. Open and edit the Library, and then import it into any Library.

Linking HMI Elements to Text in a String Library

1. Place a Frame, Button, or Fixed Text HMI element. Within the element
properties, click the String from String Library option.
You can either link a Text ID line directly, or use an MI to indirectly
provide the Text line ID.

Note that the size of the HMI element must be large enough for the longest
text line it may hold.
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-

Button

HMI Object type: Button

Position

Leit T

Top 3

Width 122 | Click to link
Height R text string
Piopeilie: v

| Text futton

Shng from Storage  <Mouse Chck>

Open Storage Link toan M
to link to Text to provide a
lime |0 lime number

: % Strings Library Selector
Forit
Appearance {+ Direct: Select Storage Sting " Indiect: Select Storage Sting ID
B ackground Cohor | |
Foroground Colon R TR Tt Pattem (Determines field length)
Background Style Sting
SaoniE | [Test_To_Display
Touch
Hide Font
Dale | =] |MS Sans Sesif (14.8) |
Marking view |

Switching Libraries

To switch Libraries, use one of these methods:

#» Use the Ladder function Strings>Set String Library
¢ Write a value to SI 491 Switch current Text Library

ASCII String

You can display a vector of MI, ML, or DW values as an ASCII string. The value
of each byte in the vector is displayed as an ASCII character. You can also
enable a user to enter characters directly into the variable by pressing keys on
the Vision keypad. ASCII String is located on the Text Variable menu.

VisiLogic: HMI Applications

77



About the HMI Display and Keypad Standard and Enhanced Vision Divisions

Stat-Up Dizplay

et To Dizplay

- Variable: ASCII String

|MI 2 Set Paint - the target value |15

— String Pattern [Determines field length) Font
"‘-~|Tn3:-:t_Tu:u_DispIa}I IMS Sanz Serf [8)

v % K.eypad Entry
) |English Ea

Diescription : I\-"arial:nle 2
Link. : ]MBD _I OF. | Cancel | Help |

The Display String 'trigger' MB is set and reset by the user. Note that the OS
refreshes the string and resets the MB when the MB turns ON. If the MB is
continuously set by the application, the change in status will not occur and the
string will not be refreshed.

Notee | String Pattern defines the size of the text field. The default string 'Text
To Display' will provide a field long enough to contain most strings.

* | SBs 33 and 34 function when an HMI Display that calls a subroutine
is loaded/unloaded from the display screen.

In cases where a Display contains a Variable:ASCII String, and the
linked subroutine contains the Display String 'trigger' MB, you can reset
this MB when the Display unloads by using the falling edge of SB 34.

Start-Up Dizplay

Ext To Display

String Fatterr

ITe:-:t To Dizplay

To create a field that contains enough bytes to provide for the width of the
ASCII characters in a variable string, enter a line of text in String Pattern that
contains characters of the necessary width.
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M 4 5 B 7 5 g 10 11
ASCll value |45 |54 54|58 54|2|:| 2EI|4F 49|44 50 |52 41 |4c 4F|

TEXT TO DISPLAY

IT ext Ta Dizplay

The character ' W ' is generally the widest character in a font set.

ring Pakteiry
I W

IWWWWWWWWWWWWWWW
TEXT TO DISPLAY

Notee | A vector is read either until the end of the defined vector length, or

until a 'null' character is encountered. By adding a null character to
the end of the stream, you can mark the end of a data string. This can
prevent other data, that might be present in a vector, from being
added to the data string when the vector is read.

Entering ASCII via keypad

When you select Keypad Entry, the user can enter upper and lower case
characters as well as symbols.

Vision: Standard Keypad

W Lision | 20
Bl cevere [EE ’
— s

L.
L
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Vision: Color Touchscreen models

When the user touches the screen, the virtual keypad opens. Use the top
arrows to page between keypads to enter capital letters, lower-case, and

symbols.
Variable Mame
Text entered via
F keypad
- , PLQY Del | B
Use Arrows o page
betweaen keyboards
R T e
A S D F G [2]3]% o
awerthegss%sa-* ()
zxcva ‘iili""-;:?lt
ﬂ SPAQZz x ¢/ vibl, v+ ] e¢ s *
SPle ® «| » 2|22 :
SPACE

Vision: Monochrome Touchscreen models
There are 2 types:
+ Models which comprise both an HMI function keypad and a virtual keypad
(V280).

rE nter User Mame

DAVID

1

Qw

AlS
E

|Enter IJzer Mame II

DAWID wark, |E nter Uszer Mame

112131215 D& 10 ook, (32

qlwle|r |t @l 11" 1117

ajs|d|f |g El#g]|-|+l=]|-|'1<]>
e A P LT e

Clear All E"B s ESC 1 $ _ I \ -

_mrulE—l—EI Space |4 | P

80 VisiLogic: HMI Applications



About the HMI Display and Keypad Standard and Enhanced Vision Divisions

# Models which comprise only a virtual keypad (V290).

Notee | Tn models which comprise only a virtual keypad (V290), the virtual
keypad opens whenever the user touches a keypad entry variable that
is currently displayed on the screen.

However, in models which comprise both an HMI function keypad and a
virtual keypad (V280), the virtual keypad must be activated by turning
SB 22 Enable Virtual Keypad ON. This must be done at power-up, or
before the Display containing the keypad variable is entered.

In addition, the Keypad entry variable must be assigned a Touch
Property.

Strings: Display RTC (ASCII)
You can display an RTC value as an ASCII string by using the RTC to ASCII
function together with the ASCII String variable.

To use Display RTC:
1. Select RTC to ASCII from the String menu on the Ladder toolbar.

2. Place the function in the net, and select a display format; both European
and American format are available.

3. In the HMI Display, select Display RTC from the Text Variable menu.

When the program shown below is downloaded, pressing key 1 on the Vision's
keypad will display the current time on the Vision's LCD.
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SB 41 MEB O :
Ky #1 Fefresh Display ] ] ] o
— | [ ] B ERN

. BTCToASC

MI D
j5*%’""“-"3‘Far|: ToASCILB

bz g2

didld
ddddddddd

I Start-Up Display

Help

2 Variable: ASCII String
e
Start of Yector [Each register byte comains one character] Mumber of Chasacters [Determanes vector length)
[MI0: RTC ToASCI: B (Sting address | [15 -

String Patlern [Detesmines field langth) Font
[Tewt_To_Display |I'-1‘S Sane Senf (8] j

™ Wi Keypad Eniry

9 E

| Deseiiption : [Vaiable 1

L8 Refreshc  MB 0: Fefresh Display JI oK, Cancel | Help |

Password: Keypad Entry
You can insert a Password Variable that requires operators to enter a password
via the controller's keyboard.

Note that Passwords are handled differently in Standard and Enhanced Vision
Divisions, as described below.

Standard Vision

Notee | SB 250, Keypad Entry within Limits, turns ON when a password is
correctly entered; SB 251, Keypad entry exceeds limits, turns ON when
a password is incorrect. You can use the status of these bits, for
example, to provide a jump condition to another Display. When either
of these SBs turns ON, the index number of the active variable is stored
in SI 249.

1. Select Password from the Numeric menu, and drag your cursor across
the screen to create the Password field.

2. Click Link to assign either a Constant value or DW. Note that selecting DW
also enables you to set the number of asterisks shown in the Password
field.
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Standard and Enhanced Vision Divisions

Shapes
; E o o, 3 Variable: Password
e D Vision] 2(m)
Test (2] .
AR i =] [MssansSeiti®) ]
#a  Image
gf ii Deserption : |Passwornd
= Uk :  [DUnsH 1234 0k | concel | Hep |
il ﬁ B Set Password Value
Gragh @ @, Diect Mg Const 4
o ] — = o |
_Concel |
DEC =
Heb |
a
Notee | Standard Vision division: When an HMI keypad entry variable is active,

and the Enter key is pressed on the controller keypad, SB 30 Variables
Locked turns ON. This can be used as a Jump condition.

Enhanced Vision

The Password field is a touch-screen button. When the user touches it, the
virtual keypad appears, enabling the user to enter the password.

1. Select Password from the Numeric menu, and drag your cursor across
the screen to create the Password button.

2. Assign Display text to be shown within the button. If you leave this blank,
asterisks will be shown in the button by default.

3. Click Link to assign either a Constant value or DW.

4. Assign an MB to Legal Entry; this MB will turn ON when the correct
password is entered. You can use this to jump to another Display.
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[

=

Fomat: |

Shapes I Start-Up Display

(o3 ) | Password

Tewt [Bi]

m i"l' i"i 3 Yariable: Passwaord

#4  Image

B i E

i

Murregic

B mﬁl

Grapk Password Keybozrd Type:| Comples = f_I

Display Teat: [Password

= Congtant String ™ String from Library

Dezcrption ; |Ertar password

Links

f* Constant Sting Steing frem Librasy

Description Font: |MS Sans Seif [14F = |

Link: [DUnSH 12345

Hidle: |

Colors
@ Bockco I
J QJ Properlies

Dizable views. |

.| 2| Font: M3 Sans Sesif [14.£ *)

Marking view!]

Legal entiy: [ME 2 [R]- Legal entiy

_| gl lﬂmerl Center Center =
J @ Shyle: 30 [Pressed) -
e |7

ok | Cancel | Hew |

Note that you can limit the number of attempts by using SI 45 Numeric Key
Entry Out of Limit - Counter of Attempts (Enhanced) to jump to another

Display.

PN BN password |- -
..... BB —|_i‘wre|;-_[
Numsic Koy &—
”'3.“3.‘.-3 L

SI1253 the user can change the password (or view it when the controller is On-

Line)

Timers: Displaying Values

A Timer Variable shows a timer's value in a Display.

1. Create a Variable field, and then select Timer.
2. Select from the features and formats shown below.
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HH: MM S5 b

Click here: ; Timer x|
- To dispilany the timer's
preset walue. sl nme d
- Toenable the timer to be I — Select a Display farmst
=et wia the controller's keypad timgr \\:ralue_ 2 and fomt.
| Display 5,
Wihen Preset iz selected. click ] g:emaining time |- Fomat
B FrESE |5 SRlECiEn, CiC . -
here to enahle Keypad Entry. '| {~ =Elapsed lims 53.hh Llj|l IMS Sans Seri [3) J
55
& Keppad Ertry il
bAM 55 %
([HH:MM
D eseripkian * |&larm Timer tM:5 S Hh
ILink 2 ‘T 1: &lamn Tirner 0k Cancel
Display/Preset Counter Values
A Counter Variable shows a counter's value in a Display.
1. Create a Variable field, and then select Counter.
2. Select from the features and formats shown below.
Start-Up Display
C0 Remaining Elapzed
Current -99999 -35339
Preset [-99999
Preset reached
x|
ic =% Cock =& Timer = Counter =
Length—  —Foni
st | (£ Aemening elue 39999 -
Prasat  Elapeed valus Iﬁ_ﬂ |VIMS Euns Sﬂll |E] I
™ W Keypad Eniry
Descripton : [v/anable 4
Link ©  [C2:5talus Sensor 2 o ok | cowe | hen |

'Touch' Property (Touchscreen models only)
When a touchscreen controller, such as the V280, is selected in Hardware
Configuration, you can assign Touch properties to any screen element. With
the exception of keypad entry variables, Touch elements are linked to MBs.
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1. Select any screen element, then click the Assign Touch Property button;
the Select Operand box opens, enabling you to link an MB.

When this element is touched, the linked MB will turn ON, when the element is
not touched, the MB will be OFF.

X

Elkl

Cancel |

Help |

To edit the MB that is already linked to the Touch element, select the element
and then click the Assign 'Touch" Property icon; the Select Operand box opens.

Notee | An MB that is linked to a 'Touch' element cannot be linked to any other
element on the Display. The MB may be linked to "Touch' elements in
different Displays.

Text

Fonts
Fonts are used in text boxes and to display Variable data.

Notee | Fonts are not standardized. For example, two different PCs may both
contain a font called Arial. Displays created on one PC using that font
may look different or distorted when opened on the other PC. This can
be fixed by opening the application and replacing the font; you may
replace the font with a font of the same name to solve this problem.

Font Handler
Font Handler enables you to define the fonts and character sets you use to
write text in Displays.
Use Font Handler to:

& Add fonts. Note that VisiLogic is supplied with a single default font.
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# Define fonts, including size, style, and effect.

@ Delete unused fonts, and unused characters. This can dramatically
decrease the font memory requirements.

@ Select foreign or special characters, such as degree signs.
Using Font Handler

Open Font Handler by clicking the “# icon on the toolbar, clicking it in Text
Properties, or by selecting it from the HMI menu.

IJze these buttons to define
the character set for the
selected font.

EA Font Handler
Fonts used
in Displays L ser-defined fonts. Table of available characters in the sellected font.
are checked. o
Use | Var | H P N P
15 Sas et () Il | Iksatall | | 1] 2| 3| A FE
A 1 elA e L[]
Garamond [20] Defsult i II
DOpen the : i [i k]t [m[n o
Fant dialag [a2) EREMN -
showen below I el .Clilck. L R O
|- I [N O O I A |
Delete fonts Add New Font ﬁ i individual A (e[~ @]
T — ﬁ charactersto ® s % KK g
I Change Attibuite = =LA
Flash — Munetic: select them. FEET QT
mermary T] pRAOCOOOBExB0000YRSB
capachty. Dlats AT ; Elearﬁ.l| afé?ff%‘;éf%f?_ri].
Tuuchacreen[ . 5Ro 6656 +0ua o i
g LI Set Variable Name Fort. |
E%g%l)s' i ‘5& Find all displays using a {70k ]| Cancel | Help |
g }  certain font.

International characters are supported via the Script box, which displays all
Windows fonts installed on your PC.

Notee | Color Vision models, such as V570, use default system fonts. These
fonts (which are highlighted in grey) contain a limited character set,
and cannot be modified.

To add a font that contains additional / multilingual characters, click on
the Add New Font button..
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Text

Fant: Font style:
Solect I"-.J'er-:lana IFi eqgular
-Font Trek Generation 1 Y Fegular
-Style 3
-Size Webdings Bald
Effact (} wingdings ol TFalic

then select Ok
the font is defined
for use in your

Displays.

Font Handler

Select All

Drefault

[a-2]

[2-<]

Murneric:

Clear Al

Sy Zi L= T

ad H wingdings 2

' wingdings 3
B 'winSaft Maskh

=
|

Mote + ision
cantrallers do not

2 x
ok |
=N

Cancel

—Effects support italics.
[ Stikeout
[ Underline | AaBDYyZz
Calor:
| I B lack =] | Script
I'W'estern ;I

Note < Any characters within a font that are too big to be displayed on the
controller's LCD will be marked in red.

X

~Table of available characters in the selected font.

o S T

O: e (i T -.Em
o9 on= -GN

[mHY

Uzer-defined fonts.

[ M5 Sanz Serf [8]

AddMewFort |

Delete Font |

Delete All Unused |

PR ERE

Ok

| Eancell Help |

If you are using an Enhanced Vision with a touch screen, you can select the
keyboard that Vision displays for Keyboard Entry variables.
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0T ISTETTRTRTT - |
K.eppad Entry Y ariable Keyboard |Western J
W'estern
! L Cyrillic:
— |
Text: Fixed
Fixed (constant) text does not change according to run-time conditions.
To place fixed text messages in a Display:
g} Bk = Al
E? ! Stact-Up Desplay
1 Click the Text Box L.
iCan; yaur cursor tﬂ
turns into & cross- =
hairs 5
iy
2.Click in the Dizplay to anchar the
curzor, then drag the cursor across : :
the screen; when you release the [ HMI Db]&ﬂt t}'pe Text
mauze button, the Text properties Pozition
hox opens . Lekt A0
e — | Tc? n
3. Click here to enter text. Width e
Height i
\ Attributes
T et B Test
Font M5 Sans Senf (8]
Edit Dbject
U=ze the Font Handler to add fonts L . 3=
and determine fort sizes AL L .ﬂ! e
lFunt Handler A cMouse Chcks
String Library
Use String Library to store text strings within the controller's FLASH memory,
and then display them on the controller's LCD. You can, for example, organize
text into different String Libraries—for example, separate libraries for Spanish,
English and Italian—pull strings into HMI objects, and then switch libraries to
change the display language.
These strings can be displayed in the following HMI elements:
« Frame
+ Button
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% Fixed Text
String Libraries also provide the text for Alarms, and can be used in Trend
Curve Properties.
There are:

& 16 String Libraries containing up to 1024 strings each. You can change the
library default names.
Via String Library> File, you can opt to use only 4 or 8 libraries; in this
case the total number per library is 2,046 strings.
Note that each library contains sections in the 3,000 range, that are
‘greyed'; these are reserved for system use.

# Each string can contain up to 128 characters.

The total memory capacity for all String Libraries is 64K.

L | This feature is not available in Standard Vision controllers.
How String Library works

Only one library is active at a time. This means that at any given time, all
elements that pull text from a library are using the same library.

However, each HMI element may be linked to a different line ID # within that
String Library.

In the following figure, the buttons are linked to different text lines. Each time
a different String Library is called, the button text changes.

& String Editor
Sk @ 3 X Fort: Verdsna(i1)

% String Editor
S @ 3 0 Fort: Verdsna(i1) -

Approywed Rejected
Aprovado FRechazado
Apporouvwe Rejete

]l The button on the left is linked to Text line 1D 0 ]

The button on the right is linked to Text line 1D 1 ]l

Configuring Strings

1. Click the String icon on the navigation tree or toolbar to open the Strings
editor.
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Text

Project Edit Wiew [nsert Quid Connection Ladder HMI Took Help
o | EEﬁﬁ@v’S‘ﬁ oy @ @ ] @ | DiectConnection » | 2
e MRT T S g | (2] [ L | P | A B | Propediss..

D&E i B

D '@‘ Sting Libwasy
8! Swing_Library 1
"8 Sting_Librany_2
8 Stiing_Librany_3
P8 Sting_Library 4
Y8 Sking_Libeaty_5
Y8 Shing_Librany_G
¥S* Sting_Library_7
Y8 Shing_Librany_8
& web Service
= () Data Table:

e g - SngCc_ [

o]

. R

| 2 | [Double-click row to edk String]

[ 5 |

| & |

[ 7

| 8 |

[ g |

< L.
O, Cancel

2. Click on File> Rename Library to assign a unique name to the Library

-3 String Library - Configuration

Letters 1

Symbols_3 & HMI String Library
Stings_Stosage 4 |

Shings Storage. 5 Enter Library Mame [English letters only)
Shings_Storage_b |H ehiew

Stings_Stosage_7

3

[ 0 |
[ 1|
[ 3 ]

Shings Stwage 8 '
renyra—y

3. Double-click on a row to open the String Editor.
Note that the String Editor opens strings according to the ID #. In the
following figure, the first three messages are displayed for String Libraries
Letters_1, Numbers_2, and Symbols_3.
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Text

'."...';'.'..'Slrings Library - Editing

Fle Shings Help

Y3 & b CurentStorage: Numbers 2 |=| Find Find Newt_|

~ Strings rLetters 1

; Symbolz_3 ~
Stings_Storage_4
Stings_Storage_5 MS Sans Sei (8]
Stongs_Storage_B
Strings_Storage_7
Shri Storage 8
. ULEE LN

% @ 3 X Font: MSSans Serif (8) - XY E%

[Strings_Storage_4
Stiings_Storage 5

|
| ik

3. Place your cursor in the desired String Library row, and type in text. You

can also include indirect text from an MI vector.
The text is displayed in the PLC Preview window.

© Siring Editor

T @ BLX Fort: M Sens Sert (8) IR X A8 %,

) 31D [riceqt Indhrect String |

E4

o I w0
T om0
= & W O
& m’awn

;:\'l‘l'nili_ m;l'-! 7

Shorage % Indirect String
Shrgs_Storage_B

Hote
[Each charactes wil be stoeed 1 & smge byte
it Start of Sting : M1 100 - Hame |
Stng length : |8 =l
(1].4 I Cﬂud|
| T ] L
0
0
Display 0030309 o 0
5 | 0
6 | 0
0
0
Ok | Cancel | Hep |

You can also break text lines by including Carriage Return + Line Feed

characters.
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B String Editor
@ﬂ? [3* X Font: MSSans Serif (8) - X v‘ %
Insert Carriage return-linefesd |

a4 a a
1/1|1
1
:.I|_||_J'_|||_-|||u:_:'. h e | [ |
Stings_Storage 5
Stings_Storage_B |
Shirgs_Storage 7
< B B »
PLC Serean Preview Irifa
Shireg at 1D: 0 Char index 1
Sting uzes 12 of 127 characters
[ [ Storage Memoy Usage | % |
0
H 0
hello 0
world 4 | 0
4 E 1]
[ | 0
7 | 0
[ 8 | 0

OK | Concel | Hep |

Note that you can find Unreferenced Strings via the binoculars icon on the
String Library toolbar.

Importing/Exporting Strings to/from Excel or .csv
These tools are located on the String Library File menu.

1] Excel: you cannot create an Excel file and import it. You must export a
String Library from a String Library, delete any undesired information,
and then enter your own strings.

.CSV: you must use a delimiter that does not appear within the string's
data, or the values will not be separated according to expectations.

Import/Export from Excel
1. Select all of the Strings in a Library. and then select Export
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Text

B String Library - Configuration

a
b

=]

Fila Strings Help

A2 S BAEPD E 04 34 | Cument Library: Sting_Libeary_1 -
Stings Select All
ER Shing Contert
[ 0| 5Dec
1 5Dec
7Dec
BDec
N 3Dec
| 5 | 10Dec
| 6 |
| B |

2. From the File menu, select Export to Excel.

B String Library - Configuration
File | Strings  Help .
Rename Library rF &% B Curend Libeary;,  Sting_Libeary_1
Mumber of Libraries 8 8
I/ Equrt selection to Excel
& Irtgort From Excced

3. Open and edit the Library, and then import it into any Library.
Linking HMI Elements to Text in a String Library

1. Place a Frame, Button, or Fixed Text HMI element. Within the element
properties, click the String from String Library option.
You can either link a Text ID line directly, or use an MI to indirectly
provide the Text line ID.

Note that the size of the HMI element must be large enough for the longest
text line it may hold.
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Left K1

Top 3

Width 122 | Click to link

Height k7] text string

Propeties v Open Storage Link to an MI

Text B to link to Text to provide a
" lime |0 lime number

Shng from Storage  <Mouse Chck> |

Ford i Strings Library Selector
Appearance i+ Direct: Select Storage String " Indiect: Select Storage Sting ID
Background Color | | l _|| |
Foroground Colon R TR Tt Pattem (Determines field length)
Background Style ) Sting
Touch
Hide Font
Dlaiide mods | =] |MS Sans Sesif (14.8) |
Markirg view

| Concel |[CTHEE )

Switching Libraries
To switch Libraries, use one of these methods:

#» Use the Ladder function Strings>Set String Library
¢ Write a value to SI 491 Switch current Text Library
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